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Chapter 1. Contacting IBM Unica technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company’s designated support contact can log a call with
IBM® Unica® technical support. Use the information in this section to ensure that
your problem is resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM
Unica administrator for information.

Information to gather

Before you contact IBM Unica technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System information."

System information

When you call IBM Unica technical support, you might be asked to provide
information about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
Unica applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, you can obtain the version number of any IBM Unica application by
viewing the version.txt file located under the installation directory for each
application.

Contact information for IBM Unica technical support

For ways to contact IBM Unica technical support, see the IBM Unica Product
Technical Support website: (http://www.unica.com/about/product-technical-
support.htm).
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Chapter 2. Preparing to Install

Installing IBM Unica products is a multi-step process that involves working with a
number of software and hardware elements that are not provided by IBM Unica .
While the IBM Unica documentation provides some guidance regarding specific
configurations and procedures required to install IBM Unica products, for details
on working with these systems that are not provided by IBM Unica , consult those
products' documentation.

Before you begin to install the IBM Unica Marketing software, plan your
installation, including both your business objectives and the hardware and
software environment required to support them.

Marketing Platform basic installation checklist
Read this chapter to gain an overview of the installation process and verify that
your environment, planned order of installation, and knowledge levels fulfill the
prerequisites.

The following list is a high-level overview of the steps required to perform a basic
installation of the Marketing Platform. Additional details about these steps are
provided in the rest of this guide.

Prepare the Marketing Platform data source

1. “Step: Create the Marketing Platform system table database or schema” on
page 7
Create the Marketing Platform system table database or schema and record the
information.

2. “Step: Configure the web application server for your JDBC driver” on page 8
Add the database driver for the Marketing Platform system table database to
the web application server classpath.

3. “Step: Create the JDBC connection in the web application server” on page 9
Create a JDBC connection to the Marketing Platform system table database. Be
sure to use UnicaPlatformDS as the JNDI name for the connection.

Install the Marketing Platform

1. Chapter 4, “Installing the IBM Unica Marketing Platform,” on page 11
Download the IBM Unica and Marketing Platform installers.

2. “Step: Obtain required information” on page 16
Gather the required database and web application server information.

3. “Step: Run the IBM Unica installer” on page 17
The IBM Unica installer launches installers for all products it finds in the same
directory.

4. “Step: Create and populate the Marketing Platform system tables manually, if
necessary” on page 18
If your company policy does not permit the installer to create the Marketing
Platform system tables automatically, or if automatic creation did not occur due
to a connection failure, create the tables manually.
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Deploy the Marketing Platform

1. Chapter 5, “Deploying the IBM Unica Marketing Platform,” on page 21
Follow the specific guidelines for WebSphere® or WebLogic.

2. “Step: Verify your Marketing Platform installation” on page 25
Log in to IBM Unica Marketing and check basic functions.

Configure the Marketing Platform

1. Chapter 6, “Configuring the IBM Unica Marketing Platform After Deployment,”
on page 27
Set password constraints or configure the Java™ Message Service for optimum
performance of the Scheduler, or install reporting.

2. Chapter 9, “Installing Reports,” on page 47
If you plan to use the reporting feature in any of the IBM Unica Enterprise
products, see the Reporting chapter.

IBM Unica components and where to install them
The following diagram provides a brief overview of where to install IBM Unica
applications.

This setup is the basic installation that functions. You might require a more
complex, distributed installation to meet your security and performance
requirements.

Prerequisites
The following are prerequisites for installing IBM Unica Marketing products.

System requirements
For detailed system requirements, see the Recommended Software Environments and
Minimum System Requirements guide for the IBM Unica Marketing products you
plan to install.

JVM requirement

IBM Unica Marketing applications within a suite must be deployed on a dedicated
Java Virtual Machine (JVM). IBM Unica Marketing products customize the JVM
used by the web application server. You might need to create an Oracle WebLogic
or WebSphere domain dedicated to IBM Unica Marketing products if you
encounter JVM-related errors.
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Network domain requirement

IBM Unica Marketing products that are installed as a Suite must be installed on
the same network domain, to comply with browser restrictions designed to limit
cross-site scripting security risks.

Knowledge requirement
To install IBM Unica Marketing products, you must possess or work with people
who possess a thorough knowledge of the environment in which the products are
installed. This knowledge includes the operating systems, databases, and web
application servers.

Required permissions
Verify that your network permissions allow you to perform the procedures in this
guide, that you have logins with appropriate permissions, and that the product
installation files that you download have appropriate permissions, as follows.
v You must have the administrative login name and password for your web

application server.
v You must have administration access for all necessary databases.
v You must have write permission for all files that you must edit.
v You must have write permission for all directories where you must save a file,

such as the installation directory and backup directory if you are upgrading.
v The operating system account that you use to run the web application server

and IBM Unica Marketing components must have read and write access to the
relevant directory and subdirectories.

v You must have appropriate read/write/execute permissions to run the installer.
On UNIX, the user account that performs the IBM Unica product installation
must be a member of the same group as the user account that installed the web
application server on which it will be deployed. This is because the web
application server needs access to the product's file system.

v On UNIX, all of the installer files for IBM Unica products must have full execute
permissions (rwxr-xr-x).

If you are upgrading or installing in a cluster
If you are upgrading, you should read Chapter 8, “Upgrading the IBM Unica
Marketing Platform,” on page 31.

If you are installing the Marketing Platform in a cluster, you should read
Chapter 7, “Installing the IBM Unica Marketing Platform in a Cluster,” on page 29.
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Chapter 3. Preparing the IBM Unica Marketing Platform Data
Source

This section provides the information you need to set up the database and JDBC
connection for the Marketing Platform system tables. You will enter the details
about this database when you run the IBM Unica installer later in the installation
process, so you should print and fill in the “Marketing Platform database
information checklist” on page 10.

Step: Create the Marketing Platform system table database or schema
1. Work with a database administrator to create the Marketing Platform system

table database or schema.
Follow these vendor-specific guidelines.
v If your Marketing Platform system tables are in Oracle, you must enable auto

commit for the environment open. See the Oracle documentation for
instructions.

v If your Marketing Platform system tables are in DB2®, set the database page
size to at least 16k (32k if you need to support Unicode). See the DB2
documentation for instructions.

v If Marketing Platform system tables are in SQL Server, you must use either
SQL Server authentication only, or both SQL Server and Windows
authentication, because the Marketing Platform requires SQL Server
authentication. If necessary, change the database configuration so that your
database authentication includes SQL Server. Also be sure that TCP/IP is
enabled in your SQL Server.

If you plan to enable locales that use multi-byte characters (for example,
Chinese, Korean, and Japanese), ensure that the database is created to support
them.

2. Have the database administrator create an account that can be used to create
and populate the Marketing Platform system tables. This is done later in the
installation process, and can be performed manually or automatically by the
IBM Unica Marketing installer
This account must have at least the following rights.
v CREATE TABLES
v CREATE VIEWS (for reporting)
v CREATE SEQUENCE (Oracle only)
v CREATE INDICES
v ALTER TABLE
v INSERT
v UPDATE
v DELETE

3. Obtain the information about your database or schema and the database
account and then print and complete the “Marketing Platform database
information checklist” on page 10. You will need this information during later
steps in the installation process.
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Step: Configure the web application server for your JDBC driver
You must obtain the correct JAR file for the JDBC connections the Marketing
Platform requires. You must also add the location of the file to the classpath of the
web application server where you plan to deploy the Marketing Platform.
1. Obtain the latest vendor-provided Type 4 JDBC driver supported by IBM Unica

Marketing, as described the the IBM Unica Marketing Platform Recommended
Software Environments and Minimum System Requirements document.
v If the driver does not exist on the machine where the Marketing Platform

will be deployed, obtain it and unpack it on the machine where you plan to
deploy the Marketing Platform. Unpack the drivers in a path that does not
include spaces.

v If you obtain the driver from a machine where the data source client is
installed, verify that the version is the latest supported by IBM Unica .

The following table lists the driver file name or names for the databases
supported for IBM Unica Marketing system tables.

Database File(s)

Oracle ojdbc5.jar

DB2 db2jcc.jar

db2jcc_license_cu.jar - not required in V9.5 and higher

If your database is DB2-9.7, use driver version DB2 9.7
V3.57.110

SQL Server You must use version 1.2 of the SQL Server driver

sqljdbc.jar

2. Include the full path to the driver, including the file name, in the classpath of
the web application server where you plan to deploy the Marketing Platform,
as follows.
v For all supported versions of WebLogic, set the classpath in the

setDomainEnv script in the WebLogic_domain_directory/bin directory where
environment variables are configured. Your driver entry must be the first
entry in the CLASSPATH list of values, before any existing values, to ensure
that the web application server uses the correct driver. For example:
UNIX
CLASSPATH="/home/oracle/product/10.2.0/jdbc/lib/ojdbc14.jar:

${PRE_CLASSPATH}${CLASSPATHSEP}${WEBLOGIC_CLASSPATH}
${CLASSPATHSEP}${POST_CLASSPATH}${CLASSPATHSEP}${WLP_POST_CLASSPATH}"

export CLASSPATH

Windows
set CLASSPATH=c:\oracle\jdbc\lib\ojdbc14.jar;%PRE_CLASSPATH%;
%WEBLOGIC_CLASSPATH%;%POST_CLASSPATH%;%WLP_POST_CLASSPATH%

v For all supported versions of WebSphere, you set the classpath in the next
step, while you are setting up the JDBC providers for the Marketing
Platform.

3. Make a note of this database driver classpath in the Marketing Platform
database information checklist, as you will need to enter it when you run the
installer.

4. Restart the web application server so your changes take effect.
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During startup, monitor the console log to confirm that the classpath contains
the path to the database driver.

Step: Create the JDBC connection in the web application server
The Marketing Platform web application must be able to communicate with its
system table database using a JDBC connection. You must create this JDBC
connection in the web application server where you plan to deploy the Marketing
Platform.

Important: You must use UnicaPlatformDS as the JNDI name. This is required, and
is noted in the “Marketing Platform database information checklist” on page 10.

Note: When the Marketing Platform system tables are created in a different
schema from the default schema of the database login user, you must specify that
non-default schema name in the JDBC connection used to access the system tables.

Information for JDBC connections
When you create a JDBC connection, you can use this section to help you
determine some of the values you must enter. If you are not using the default port
setting for your database, change it to the correct value.

This information does not exactly reflect all of the information required by the web
application servers. Where this section does not provide explicit instructions, you
may accept the default values. Consult the application server documentation if you
need more comprehensive help.

WebLogic

Use these values if your application server is WebLogic.

SQLServer

v Driver: Microsoft's MS SQL Server Driver (Type 4) Versions: 2005
v Default port: 1433
v Driver class: com.microsoft.sqlserver.jdbc.SQLServerDriver
v Driver URL: jdbc:sqlserver://

your_db_host:your_db_port;databaseName=your_db_name

v Properties: Add user=your_db_user_name

Oracle 10g and 11

v Driver: Other
v Default port: 1521
v Driver class: oracle.jdbc.OracleDriver
v Driver URL: jdbc:oracle:thin:@your_db_host:your_db_port:your_db_service_name

v Properties: Add user=your_db_user_name

DB2

v Driver: Other
v Default port: 50000
v Driver class: com.ibm.db2.jcc.DB2Driver
v Driver URL: jdbc:db2://your_db_host:your_db_port/your_db_name

v Properties: Add user=your_db_user_name
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WebSphere

Use these values if your application server is WebSphere.

SQLServer

v Driver: N/A
v Default port: 1433
v Driver class: com.microsoft.sqlserver.jdbc.SQLServerConnectionPoolDataSource
v Driver URL: N/A

In the Database Type field, select Other.

After you create the JDBC Provider and Data Source, go to the Custom Properties
for the Data Source, and add and modify properties as follows.
v serverName=your_SQL_server_name

v portNumber =SQL_Server_Port_Number

v databaseName=your_database_name

v enable2Phase = false

Oracle 10g and 11

v Driver: Oracle JDBC Driver
v Default port: 1521
v Driver class: oracle.jdbc.OracleDriver
v Driver URL: jdbc:oracle:thin:@your_db_host:your_db_port:your_db_service_name

DB2

v Driver: DB2 Universal JDBC Driver Provider
v Default port: 50000
v Driver class: com.ibm.db2.jcc.DB2Driver
v Driver URL: jdbc:db2://your_db_host:your_db_port/your_db_name

Marketing Platform database information checklist

Data source type

Data source name

Data source host name

Data source port

Data source account user name

Data source account password

JNDI name UnicaPlatformDS

JDBC driver class

JDBC connection URL

JDBC driver classpath on your system
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Chapter 4. Installing the IBM Unica Marketing Platform

Obtain the DVD, or download the software from IBM Unica .

If you received your IBM Unica installation files on a DVD, or if you created a
DVD from a downloaded ISO image file, you must copy its contents to a writeable
directory available to the system on which you will be installing the IBM Unica
products. You cannot run the installers from a DVD or other read-only volume.

Important: Place all of the installation files in the same directory. This is an
installation requirement.

To install the Marketing Platform you need the following.
v The IBM Unica master installer
v The Marketing Platform installer

Setting permissions on UNIX-type systems

On UNIX-type systems, ensure that the installation files have full execute
permissions (rwxr-xr-x).

Installing on non-English operating systems

When you run the IBM Unica installer on an operating system configured for a
language other than English, you must set the lang environment variable to the
English locale (for example, lang=en_us) before you run the installer. Use the value
appropriate for your operating system. When the installation is complete, you can
change the lang variable to the desired language.

Choosing the right installer file

The IBM Unica Marketing installation files are named according to the version of
the product and the operating system with which they are meant to be used,
except for UNIX files intended to be run in console mode, which are not operating
system-specific. For UNIX, different files are used depending on whether the
installation mode is X-windows or console. If different installers exist for 32- and
64-bit operating systems, these numbers are also included in the file name. If no bit
number is included, the installer is for both 32-bit and 64-bit operating systems.

Here are some examples of the installers you would choose based on your
installation environment.

If you plan to install on Windows using either GUI or console mode —
Product_N.N.N.N_win.exe is version N.N.N.N and is intended for installation on the
Windows 32-bit or 64-bit operating systems.

If you plan to install on Solaris using X-windows mode —
Product_N.N.N.N_solaris64.bin is version N.N.N.N and is intended for installation
on the Solaris 64-bit operating system.

If you plan to install on UNIX using console mode — Product_N.N.N.N_.sh is
version N.N.N.N and is intended for installation on all UNIX operating systems.
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How the IBM Unica Marketing installers work
Read this section if you are not familiar with the basic functions of the IBM Unica
installer.

Single directory requirement for installer files
When you install IBM Unica enterprise products, you use a combination of
installers.
v A master installer, which has Unica_Installer in the file name
v Product-specific installers, which all have the product name as part of their file

names

To install IBM Unica Marketing products, you must place the master installer and
the product installers in the same directory. When you run the master installer, it
detects the product installation files in the directory. You can then select the
products you want to install.

When multiple versions of a product installer are present in the directory with the
master installer, the master installer always shows the latest version of the product
on the IBM Unica Products screen in the installation wizard.

Installing patches

You might be planning to install a patch immediately after you perform a new
installation of an IBM Unica product. If so, place the patch installer in the directory
with the base version and master installer. When you run the installer, you can
select both the base version and the patch. The installer then installs both in correct
order.

Choosing product installation directories
You can install to any directory on any network-accessible system. You can specify
an installation directory by entering a path or by browsing and selecting it.

You can specify a path relative to the directory from which you are running the
installer by typing a period before the path.

If the directory you specify does not exist, the installer creates it, assuming that the
user performing the installation has appropriate permissions.

The default top-level directory for IBM Unica installations is named Unica. The
product installers then install in subdirectories under the Unica directory.

Installation types
The IBM Unica installer performs the following types of installation.
v New installation – When you run the installer and select a directory where an

IBM Unica Marketing product has never been installed, the installer
automatically performs a new installation.

v Upgrade installation – When you run the installer and select a directory where
an earlier version of an IBM Unica Marketing product has previously been
installed, the installer automatically performs an upgrade installation. See the
Upgrading chapters for details.

v Reinstallation – When you run the installer and select a directory where the
same version of an IBM Unica Marketing product has previously been installed,
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the installer automatically performs a new installation. This overwrites all of the
files in your existing installation directory.
If automatic database table creation is available for the product, and you select
it, your data in the system tables is not modified, except for navigation menu
items. If you have modified the navigation menu, you should use the Marketing
Platform configTool utility to export those configuration properties, so you can
restore them after you reinstall. If you have not modified the navigation menu,
you do not need to do anything, as the installer recreates the default menu
items.
You might see some errors because the installer will not be able to create tables
in the database, as they already exist. You can safely ignore these errors.

Installation modes
The IBM Unica installer can run in the following modes.
v Console (command line) mode

In console mode, you enter numbers to select options. If you do not enter a
number, but press Enter, the default option is selected.
Default options are indicated by one of the following symbols:
– [X]

When this symbol appears, and you want to select an option other than the
one it is next to, first enter the number shown next to the symbol to clear that
option, followed by a comma and the number you do want to select.

– —>

When this symbol appears, and you want to select an option other than the
one it is next to, enter the number you want to select. You do not have to
clear the default option explicitly, as you do for the other type.

v Windows GUI or UNIX X Window System mode
v Unattended mode, which allows no user interaction

Unattended, or silent, mode is used when you must install an IBM Unica
product multiple times, for example when you set up a clustered environment.
For more information, see “Installing multiple times using unattended mode.”

Installing multiple times using unattended mode
If you must install IBM Unica Marketing products multiple times, for example
when setting up a clustered environment, you might want to run the IBM Unica
installer in unattended mode, which requires no user input.

About the response files

Unattended (also known as silent) mode requires a file or set of files that provides
the information that a user would enter in the installer wizard when using GUI or
console modes. These are known as response files.

The installer automatically creates these response files when you perform an
installation in console mode or Windows GUI or UNIX X Window System modes.
Therefore, you would normally run the installer in one of these modes to create the
response files before setting up an unattended run.

The response files are named installer_product.properties, except for the file for
the IBM Unica installer itself, which is named installer.properties. The installer
creates these files in the directory where the installer is located.
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Backup requirement for response files

You must create a backup version of the response files, because each time you run
in unattended mode, the installer overwrites the .properties files with an empty
version of the files. Therefore, you must replace the empty files with your
backed-up version each time you run in unattended mode.

Effect of unattended mode when you uninstall

When you uninstall a product that was installed using unattended mode, the
uninstall is performed in unattended mode (without presenting any dialogs for
user interaction).

Automatic vs. manual system table creation
The Marketing Platform installer lets you choose whether or not to allow the
installer to create the system tables in the database.

If you choose to allow the installer to create the system tables, you must provide
information that enables the installer to connect to the Marketing Platform
database you created in an earlier step. For the Marketing Platform, this is the
same information that you provide in the IBM Unica master installer for product
registration, as described in “Step: Obtain required information” on page 16.

If you choose to create the system tables manually, you must use your database
client to run the SQL scripts provided with your Marketing Platform installation.
Details for manual table creation are provided in “Step: Create and populate the
Marketing Platform system tables manually, if necessary” on page 18.

Creating EAR files for clustered deployments
IBM Unica supports clustering. The supported web application servers allow you
to deploy and manage deployments from a single administration console. To take
advantage of these features, you must use EAR files for deployments.

The master installer can create one or more EAR files containing the installed
products that you specify. You then deploy the EAR file or files that include the
products.

If you deploy more than one EAR file in a domain, the name you give the EAR file
must be unique within that domain.

You can use the IBM installer to create a new EAR file of your installed products at
any time after your initial installation. See “To create an EAR file after running the
installer” on page 15.

Note the following details about specific products.
v eMessage, Optimize, and Interact Design Time do not include a WAR file to be

deployed on a web application server, so they are not available for inclusion in
an EAR file. Interact Run Time does have a WAR file and therefore can be
included in an EAR file.

v If you plan to deploy on WebLogic 9.2, do not include the Marketing Platform in
an EAR file. See the WebLogic guidelines “Guidelines for deploying the
Marketing Platform on WebLogic” on page 21 for details.
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To create an EAR file after running the installer
Use this procedure if you want to create an EAR file after you have installed IBM
Unica Marketing products. You might want to do this if you decide you want a
different combination of products in the EAR file.

The WAR files must be in a single directory. You will run the installer in console
mode, from the command line.
1. If this is the first time you are running the installer in console mode, make a

backup copy of the installer's .properties file for each of your installed
products.
These files are located in the same directory where you have placed the IBM
Unica product installers. They are named installer_product.properties,
except for the file for the IBM Unica installer itself, which is named
installer.properties.
If you plan to run the installer in unattended mode, you should back up the
original .properties files, because when the installer runs in unattended mode,
it clears these files. To create an EAR file, you need the information that the
installer writes in the .properties files during the initial install.

2. Open a command window and change directories to the directory that contains
the installer.

3. Run the installer executable with this option:
-DUNICA_GOTO_CREATEEARFILE=TRUE

On UNIX-type systems, run the .bin file rather than the .sh file.
The installer wizard runs.

4. Follow the instructions in the wizard.
5. Before you create additional EAR files, overwrite the .properties file or files

with the backup(s) you created before you ran in console mode for the first
time.

IBM Site ID
The installer might prompt you to enter your IBM Site ID. Your IBM Site ID can be
found on the IBM Welcome letter, Tech Support Welcome letter, Proof of
Entitlement letter, or other communications sent when you purchased your
software.

IBM might use data provided by the software to better understand how customers
use our products and to improve customer support. The data gathered does not
include any information that identifies individuals.

If you do not want to have such information collected, after the Marketing
Platform is installed, log on to the Marketing Platform as a user with
administration privileges. Navigate to the Settings > Configuration page, and set
the Disable Page Tagging property under the Platform category to True.

Where to install Marketing Platform components
The Marketing Platform application contains the IBM Unica common navigation,
reporting, user administration, security, scheduling, and configuration management
features. Follow these guidelines.
v For each IBM Unica Marketing environment, you must install and deploy the

Marketing Platform once.
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v If you want to use the Marketing Platform utilities on additional machines, you
must install both the utilities and the web application. This is needed because
the utilities use the jar files in the web application. However, when you install
the Marketing Platform for this purpose, you do not have to deploy the
Marketing Platform again, nor do you have to create additional Marketing
Platform system tables.

The following table describes the components you can select when you install the
Marketing Platform.

Component Description

Marketing
Platform utilities

Command line tools that allow you to work with the Marketing
Platform system table database from the command line to import and
export configurations, create partitions and data filters, and restore the
platform_admin user. Install this on every machine where you want to
be able to use Marketing Platform utilities.

Marketing
Platform web
application

The web application that supplies the common user interface, security,
and configuration management for IBM Unica Marketing. Install this
on the machine where you plan to deploy the Marketing Platform.
Also, if you are configuring additional machines where you want to be
able use the Marketing Platform utilities, you must also install the web
application because the utilities use the JAR files included in the web
application. You should not deploy on these additional machines.

Reports for IBM
Cognos 8 BI

Reports integration components for IBM Cognos 8.4. Install this
component only on the Cognos system.

Step: Obtain required information
The installer prompts you to enter some information about your Marketing
Platform system table database and web application server. Gather this information
before you start the installation.

Obtain connection information for the Marketing Platform
database

The installation wizards for all products must be able to communicate with the
Marketing Platform system table database, to register their menu items, security
information, and configuration properties. Each time you run the installer in a new
location, you must enter the following database connection information for the
Marketing Platform system table database.
v Database type.
v Database host name.
v Database port.
v Database name or schema ID.
v User name and password for the database account.

You obtained this information when you created the database or schema and filled
out the Marketing Platform database information checklist.

The master installer tests and validates this connection information when you
perform the installation.
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Obtain information about your deployment on the web
application server

Obtain the following information about your planned Marketing Platform
deployment.
v Protocol: HTTP or HTTPS if SSL is implemented in the web application server.
v Host: The name of the machine on which the Marketing Platform will be

deployed.
v Port: The port on which the web application server listens.
v Domain name: The company domain of each machine where IBM products are

installed. For example, mycompany.com. All IBM products must be installed in the
same company domain, and you must enter the domain name in all lower-case
letters.
If there is a mis-match in domain name entries, you may encounter problems
when you attempt to use Marketing Operations features or navigate among
products. You can change the domain name after the products are deployed by
logging in and changing values of the relevant configuration properties in the
product navigation categories on the Settings > Configuration page.

Obtain information required to enable Marketing Platform utilities

If you plan to use the Marketing Platform utilities, obtain the following JDBC
connection information before you start to install the Marketing Platform.
v Path to the JRE. The default value is the path to the 1.5 version of the JRE that

the installer places under your IBM Unica installation directory. You can accept
this default or specify a different path.

v JDBC driver class. The installer automatically provides this, based on the
database type you specifiy in the installer.

v JDBC connection URL. The installer provides the basic syntax, but you must
provide the host name, database name, and port.

v JDBC driver classpath on your system.

You obtained the last three pieces of information listed above when you created
the database or schema and filled out the Marketing Platform database information
checklist.

Step: Run the IBM Unica installer
Before you run the IBM Unica master installer, verify that you have met the
following prerequisites.
v You have obtained the software products you plan to install, and you have put

all of the installers in the same directory.
v You have available the information you gathered as described in “Step: Obtain

required information” on page 16.

If your company policy does not allow the installer to create and populate the
Marketing Platform system tables during installation, see “Step: Create and
populate the Marketing Platform system tables manually, if necessary” on page 18.

Note: If you plan to deploy the Marketing Platform on WebLogic 9.2, do not
include the Marketing Platform in an EAR file. See the WebLogic guidelines
“Guidelines for deploying the Marketing Platform on WebLogic” on page 21 for
details.
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See the other topics in this chapter for details about the installer, or if you need
help entering information in the wizard.

Run the IBM Unica master installer as described here, and follow the instructions
in the wizard.
v GUI or X-windows mode

Run the Unica_Installer file. On UNIX-type systems, use the .bin file.
v Console mode on Windows

Open a command prompt, and from the directory where you placed the IBM
Unica software, run the Unica_Installer executable file with -i console. For
example,
Unica_Installer_N.N.N.N_OS -i console

v Console mode on UNIX-type systems

Run the Unica_installer.sh file with no switch.
v Unattended mode

Open a command prompt, and from the directory where you placed the IBM
Unica software, run the Unica_Installer executable file with -i silent. On
UNIX-type systems, use the .bin file.
For example, to specify a response file located in the same directory as the
installer:
Unica_Installer_N.N.N.N_OS -i silent

To specify a response file in a different directory, use -f filepath/filename. Use
a fully qualified path. For example:
Unica_Installer_N.N.N.N_OS -i silent -f filepath/filename

For more information about unattended mode, see “Installing multiple times
using unattended mode” on page 13.

Pay close attention to the installation summary windows. If errors are reported,
check the installer log files, and contact IBM Unica technical support if necessary.

Step: Create and populate the Marketing Platform system tables
manually, if necessary

The IBM installer can create the Marketing Platform system tables during
installation, but if your company policy does not permit this, you must create and
populate the tables manually.
1. Run the IBM Unica installer as described in “Step: Run the IBM Unica installer”

on page 17, but with the following differences in your choices when it launches
the Marketing Platform installer.
v Select Manual database setup.
v Deselect the Run Platform configuration checkbox.

2. After the installer finishes, create the system tables manually by running the
following SQL scripts appropriate for your database type against your
Marketing Platform system table database, as described in “Creating system
tables” on page 95.
Run the scripts in this order.
v ManagerSchema_DBType.sql

If you plan to support multi-byte characters (for example, Chinese, Japanese,
or Korean) and your database is DB2, use the
ManagerSchema_DB2_unicode.sql script.
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v ManagerSchema__DBType_CeateFKConstraints.sql

v active_portlets.sql

v quartz__DBType.sql

3. Run the IBM Unica installer again, making the following selections when it
launches the Marketing Platform installer.
v Select Manual database setup.
v Select the Run Platform configuration checkbox.

This will add default data to the system tables.
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Chapter 5. Deploying the IBM Unica Marketing Platform

When you deploy the Marketing Platform in your web application server, you
must follow the guidelines described in this section.

When you ran the IBM installer, you may have included the Marketing Platform in
an EAR file, or you may choose to deploy the Marketing Platform's WAR files
(unica.war and dashboard.war). If you included other products in an EAR file, you
must follow all the deployment guidelines detailed in the individual install guides
for the products included in the EAR file.

We assume that you know how to work with your web application server. Consult
your web application server documentation for details such as navigation in the
Administration console.

Guidelines for deploying the Marketing Platform on WebLogic
Follow the guidelines in this section when you deploy the Marketing Platform on
WebLogic.

All versions of WebLogic

Follow the guidelines in this section when you deploy the Marketing Platform
products on any supported version of WebLogic.
1. IBM Unica Marketing products customize the JVM used by WebLogic. You

may need to create a WebLogic instance dedicated to IBM Unica Marketing
products if you encounter JVM-related errors.

2. Verify that the SDK selected for the WebLogic domain you are using is the Sun
SDK by looking in the startup script (startWebLogic.cmd) for the JAVA_VENDOR
variable. It should be set to: JAVA_VENDOR=Sun . If it is set to JAVA_VENDOR=BEA ,
JRockit has been selected. JRockit is not supported. To change the selected SDK,
refer to the BEA WebLogic documentation.

3. Deploy the Marketing Platform as a web application.
4. Only if your instance of WebLogic is configured to use a JVM version 1.6 or

newer, do the following to work around an issue with the time zone database.
v Stop WebLogic.
v Download the Timezone Updater tool from the Oracle web site:

http://www.oracle.com/technetwork/java/javase/tzupdater-readme-
136440.html

v Follow the steps provided by the Timezone Updater tool to update the time
zone data in your JVM.

5. If you are configuring WebLogic to use the IIS plug-in, review the BEA
WebLogic documentation.

Additional guidelines for WebLogic 9.2 only

Follow the guidelines in this section when you deploy the Marketing Platform on
WebLogic 9.2. The guidelines describe how to modify the dashboard.war file, add
an additional path to the WebLogic CLASSPATH, and make other changes to the
WebLogic startup script, if necessary for your environment.
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1. Find the dashboard.war file under your IBM Unica installation directory, and
extract it into a temporary directory.

2. Find the stax.jar and jaxrpc.jar files in the WEB_INF/lib folder of the
extracted dashboard files, and delete them.

3. Find the portlet.jar file in the WEB_INF/lib folder of the extracted dashboard
files, remove it from that folder and move it to a folder outside the dashboard
folders. For example, you might move it to the applications directory under
your main IBM Unica installation directory.

4. Edit the setDomainEnv script, located in the bin directory under your WebLogic
domain directory, as follows.
v Find the MEM_ARGS variable where the JAVA_VENDOR is Sun. For example, in

Windows, the lines look like this.
if "%JAVA_VENDOR%"=="Sun" ( set MEM_ARGS=%MEM_ARGS% %MEM_DEV_ARGS%
-XX:MaxPermSize=128m

Change the value of -XX:MaxPermSize to 256m

v Add the full path of the portlet.jar file that you moved in an earlier step to
the PRE_CLASSPATH variable.

v Only if you are deploying on a 32-bit machine with Red Hat Linux, add
the following to JAVA_OPTIONS.
-DAFFINIUM_HOME=your_root_install_directory

v Only if your installation must support non-ASCII characters, for example
for Portuguese or for locales that require multi-byte characters, add the
following to JAVA_OPTIONS.
-Dfile.encoding=UTF-8

5. Restart WebLogic.
6. Deploy and start both the extracted dashboard.war file and the WAR file

containing the Marketing Platform (unica.war).

Additional guidelines for WebLogic 10 and 11 G only

Follow the guidelines in this section when you deploy the Marketing Platform on
WebLogic 10 or 11 G. The guidelines describe how to modify the dashboard.war
file, add an additional path to the WebLogic CLASSPATH, and make other changes
to the WebLogic startup script, if necessary for your environment.
1. If you included the Marketing Platform in an EAR file, use a zip utility to

extract the file.
You can also use the Java jar command to extract the file and re-package it in
a later step. See http://download.oracle.com/javase/1.4.2/docs/tooldocs/
windows/jar.html for information on using this command.

2. Find the dashboard.war file under your IBM Unica installation directory, and
extract it into a temporary directory.

3. Find the stax.jar and jaxrpc.jar files in the WEB_INF/lib folder of the
extracted dashboard files, and delete them.

4. Find the portlet.jar file in the WEB_INF/lib folder of the extracted dashboard
files, remove it from that folder and move it to a folder outside the dashboard
folders. For example, move it to the applications directory under your main
IBM Unica installation directory.

5. Only if your operating system is AIX® 6.1 and you are deploying on
WebLogic 11G, also extract the unica.war file, delete the xercesImpl.jar file
from WEB_INF/lib directory, and re-create the WAR file.
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6. Re-WAR the dashboard.war file and the unica.war file (if you extracted it). If
you used an EAR file, re-EAR, including the modified dashboard.war and
unica.war files.
You can now delete the extracted dashboard files, if you wish.

7. Edit the setDomainEnv script, located in the bin directory under your
WebLogic domain directory, as follows.
v Find the MEM_ARGS variable where the JAVA_VENDOR is Sun. For example, in

Windows, the lines look like this.
if "%JAVA_VENDOR%"=="Sun" ( set MEM_ARGS=%MEM_ARGS% %MEM_DEV_ARGS%
-XX:MaxPermSize=128m

Change the value of -XX:MaxPermSize to 256m

v Add the full path of the portlet.jar file that you moved in an earlier step
to the PRE_CLASSPATH variable.

v Only if you are deploying on a 32-bit machine with Red Hat Linux, add
the following to JAVA_OPTIONS.
-DAFFINIUM_HOME=your_root_install_directory

v Only if your installation must support non-ASCII characters, for example
for Portuguese or for locales that require multi-byte characters, add the
following to JAVA_OPTIONS.
-Dfile.encoding=UTF-8

8. In the WebLogic console, click the Domain link on the home page, and check
the Archived Real Path Enabled box on the Web Applications tab.

9. Restart WebLogic.
10. Deploy and start the EAR file or the WAR files (unica.war and

dashboard.war).

Guidelines for deploying the Marketing Platform on all versions of
WebSphere

Follow the guidelines in this section when deploying the Marketing Platform on
IBM WebSphere.

Check your version and fixpack

If you are using WebSphere 7, you must apply Fix Pack 17 (also referred to as
Version 7.0.0.17) or higher to address a security issue. You can obtain Fix Pack 17
here:

http://www-01.ibm.com/support/docview.wss?rs=180&uid=swg27013594.

Note that on that page, you must select the correct Fix Pack before you download.

For additional information about supported WebSphere versions, see the
Recommended Software Environments and Minimum System Requirements document.

If you are using WebSphere 6, ensure that your version is WebSphere 6.1.0.21 or
higher.
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Deployment guidelines

Follow the guidelines in this section for all Marketing Platform deployments on all
versions of WebSphere. The guidelines describe how to modify the dashboard.war
file and set required options for your deployment.
1. Set a custom property in the server as follows.

v Name: com.ibm.ws.webcontainer.invokefilterscompatibility
v Value: true
See http://www-01.ibm.com/support/docview.wss?uid=swg21284395 for
instructions on setting a custom property in WebSphere.

2. If you included the Marketing Platform in an EAR file, use a zip utility to
extract the file.
You can also use the Java jar command to extract the file and re-package it in
a later step. You can use the JDK packaged with your web server. See
http://download.oracle.com/javase/1.4.2/docs/tooldocs/windows/jar.html
for information on using this command.

3. Find the dashboard.war file under your IBM Unica installation directory, and
extract it into a temporary directory.

4. Copy and then remove the icu4j.jar and portlet.jar files from the
WEB-INF/lib directory in the extracted WAR file. Paste the copied files to the
java/jre/lib/ext directory under your WebSphere installation.

5. Re-war the dashboard.war file. If you are using an EAR file, recreate it.
You can now delete the extracted dashboard files, if you wish.

6. Deploy the IBM Unica EAR file as an enterprise application, or deploy both
the dashboard.war and unica.war files as enterprise applications.
Follow the guidelines below. Unless otherwise noted below, you can accept
the default settings.
Ensure that the JDK source level of the JSP compiler is set to Java 15 and that
JSP pages are precompiled, as follows. You must do this one time if you
deployed an EAR file, two times if you deployed separate WAR files.
v In the form where you browse to and select the WAR file, select Show me

all installation options and parameters so the Select Installation Options
wizard runs.

v In step 1 of the Select Installation Options wizard, select Precompile
JavaServer Pages files.

v In step 3 of the Select Installation Options wizard, ensure that the JDK
Source Level is set to 15.

The context root must be the following.
v If you deploy WAR files, name them /unica and /dashboard, all lower case.
v If you deploy an EAR file, name it /unica, all lower case.

7. In the server’s Web Container Settings > Web Container > Session
Management section, enable cookies.

8. Only if you are deploying multiple IBM Unica applications in separate
WAR files, specify a different session cookie name for each deployed
application, as follows.
v In the WebSphere console, in the server's Applications > Enterprise

Applications > [deployed_application] > Session Management > Enable
Cookies > Cookie Name section, specify a session cookie name that is
unique.

v Select the Override session management checkbox.
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9. Only if your installation must support non-ASCII characters, for example for
Portuguese or for locales that require multi-byte characters, add the following
to Generic JVM Arguments at the server level.
-Dfile.encoding=UTF-8

-Dclient.encoding.override=UTF-8

Navigation tip: select Servers > Application Servers > Java and Process
Management > Process Definition > Java Virtual Machine > Generic JVM
Arguments. See the WebSphere documentation for additional details.

10. In the server's Applications > Enterprise Applications section, select the EAR
file or WAR files that you deployed, then select Class loading and update
detection and set the following General Properties.
v If you deploy a WAR file, select:

– Class loader order - Classes loaded with local class loader first (parent
last)

– WAR class loader policy - Single class loader for application

v If you deploy an EAR file, select:
– Class loader order - Classes loaded with local class loader first (parent

last)

– WAR class loader policy - Class loader for each WAR file in
application

11. Start your deployment.
12. Only if your instance of WebSphere is configured to use a JVM version 1.6

or newer, do the following to work around an issue with the time zone
database.
v Stop WebSphere.
v Download the IBM Time Zone Update Utility for Java (JTZU) from the IBM

web site:
http://www.ibm.com/developerworks/java/jdk/dst/index.html

v Follow the steps provided by the IBM (JTZU) to update the time zone data
in your JVM.

13. Restart WebSphere.

Step: Verify your Marketing Platform installation
1. Access the IBM Unica Marketing URL using Internet Explorer.

If you entered a domain when you installed, the URL is the following, where
host is the machine where the Marketing Platform is installed, domain.com is
the domain in which the host machine resides, and port is the port number on
which the web application server listens.
http://host.domain.com:port/unica

2. Log in using the default administrator login, which is asm_admin with password
as the password.
You will be asked to change the password. You can enter the existing
password, but for good security you should choose a new one.
The default home page is the dashboard, which you will configure later. A
'page not found' message may be displayed on the dashboard page until it has
been configured.

3. Under the Settings menu, check the Users, User Groups, and User Permissions
pages to verify that the pre-configured users, groups, roles, and permissions are
present, as described in the Marketing Platform Administrator's Guide.
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4. Add a new user and group and verify that data is entered into the Marketing
Platform system table database.

5. Under the Settings menu, check the Configuration page to verify that the
Marketing Platform configuration properties exist.

There are additional configuration tasks, such as configuring the dashboard, setting
up user access to IBM Unica applications, and integrating with an LDAP or web
access control system (optional). See the IBM Unica Marketing Platform
Administrator's Guide for instructions.
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Chapter 6. Configuring the IBM Unica Marketing Platform
After Deployment

For a basic installation of the Marketing Platform, you must perform additional
configuration only under the following conditions.
v If you are using the IBM Unica Marketing reporting feature, see Chapter 9,

“Installing Reports,” on page 47
v The IBM Unica Scheduler and the Marketing Platform auditing function use

JMS, which by default is enabled in the Marketing Platform. There is no
requirement to install or configure JMS. However, for enhanced reliability, you
may want to run JMS on a different machine from the one where you install the
Marketing Platform and applications. This ensures that any queued schedule
runs are not lost if a machine hosting an IBM Unica Marketing application goes
down. For instructions, see “To install JMS separately from the Marketing
Platform”

v If you have a particular password policy in mind, see “To change default
password settings” to determine whether you must change the default password
settings.

The Marketing Platform has additional properties on the Configuration page that
perform important functions that you can optionally adjust. See the context help
for the properties, or the IBM Unica Marketing Platform Administrator's Guide to
learn more about what they do and how to set them.

To install JMS separately from the Marketing Platform
The IBM Scheduler uses JMS, which by default is enabled in the Marketing
Platform. There is no requirement to install or configure JMS. However, for
enhanced reliability, you might want to run JMS on a different machine from the
one where you install the Marketing Platform and applications.
1. After you install and deploy your IBM products, download and install

ActiveMQ, an open source implementation of JMS, on a separate machine.
The URL for the download is http://activemq.apache.org/download.html.

2. On the Settings > Configuration page in Marketing Platform, navigate to the
Unica > Platform category and set the following properties.
v JMS server - Set to the machine name or IP address of the machine where

you installed the Marketing Platform. Include the domain name. For
example: machine.domain.com

v JMS port - Set to the port on which Active MQ is listening. The default port
is 61616.

To change default password settings
You set password policies on the IBM Unica Marketing Configuration page in the
Unica > General > Password settings category.

These password options apply only to passwords for internal users (created within
IBM Unica Marketing), not to users imported through synchronization with an
external system (such as Windows Active Directory, a supported LDAP directory
server, or web access control server). The exception is the Maximum failed login
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attempts allowed property, which affects both internal and external users. Also
note that this property does not override any similar restriction set in an external
system.

The default settings are as follows.
v Maximum failed login attempts allowed - 3
v Password history count - 0
v Validity (in days) - 30
v Blank passwords allowed - True
v Allow identical user name and password - True
v Minimum number of numeric characters - 0
v Minimum number of letter characters - 0
v Minimum character length - 4

See the online help for descriptions of these properties.
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Chapter 7. Installing the IBM Unica Marketing Platform in a
Cluster

Use this procedure to install the Marketing Platform in a clustered environment
when you deploy on WebLogic 10 or any version of WebSphere. If you deploy on
WebLogic 9.2, see “To install the Marketing Platform in a cluster - WebLogic 9.2
deployments only.”

Note: For upgrades, see Chapter 8, “Upgrading the IBM Unica Marketing
Platform,” on page 31
1. Install one instance of the Marketing Platform.
2. Verify that your installation works.
3. Use your web application server's automatic deployment features to deploy the

EAR file in your cluster.
All machines in the cluster on which you deploy the Marketing Platform must
have network access to the database containing the Marketing Platform system
tables.

4. For enhanced performance and reliability, you may want to install the JMS
provider Active MQ on a separate machine and perform the task described in
“To install JMS separately from the Marketing Platform” on page 27.

To install the Marketing Platform in a cluster - WebLogic 9.2
deployments only

Use this procedure to install multiple instances of the Marketing Platform in a
clustered environment, only when you are deploying on WebLogic 9.2. For
deployments on WebLogic 10 and all versions of WebSphere, seeChapter 7,
“Installing the IBM Unica Marketing Platform in a Cluster.”

This procedure is required because you cannot deploy the Marketing Platform in
an EAR file on WebLogic 9.2.

Note: For upgrades, see Chapter 8, “Upgrading the IBM Unica Marketing
Platform,” on page 31
1. Install one instance of the Marketing Platform, following all the instructions in

the basic installation chapters.
2. Verify that your installation works.
3. Install additional instances of theMarketing Platform, using the following

guidelines.
v All instances of the Marketing Platform must be the same version, including

patches.
v All machines on which you install the Marketing Platform in the cluster

must have network access to the database containing the system tables of
your original installation.

v Do not create and populate the system table database. Instead, configure
each instance of the Marketing Platform to point to the system tables you
created for the original installation. When you run the installer, enter the
same database information that you entered for the original installation.
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Chapter 8. Upgrading the IBM Unica Marketing Platform

Before you upgrade the Marketing Platform, be sure you have read and
understood “Upgrade prerequisites for all IBM Unica Marketing products” and
“Marketing Platform upgrade scenarios” on page 33.

Note: Although IBM Unica changed the names of its Enterprise products with the
8.0.0. release, some configuration categories and properties on the Configuration
page retain the 7.5.x names after upgrade, to provide continuity. Properties and
categories in new installations display the updated names.

Upgrade prerequisites for all IBM Unica Marketing products
There are many prerequisites you must meet before upgrading IBM Unica
Marketing products.

To upgrade any IBM Unica Marketing product, you must meet all of the
prerequisites listed under “Prerequisites” on page 4 in the "Preparing to Install"
chapter.

In addition, you must meet the prerequisites listed in this section.

User account requirement (UNIX only)

On UNIX, the same user account that installed the product must perform the
upgrade.

32-bit to 64-bit version upgrades

If you are moving from a 32-bit to a 64-bit version of an IBM Unica Marketing
product, ensure that the following conditions are met.
v The database drivers for your product data sources are also 64-bit
v All relevant library paths (for example, startup or environment scripts) correctly

reference the 64-bit versions of your database drivers

Knowledge requirements

These instructions assume that the person performing the upgrade has an
understanding of the following.
v The basic function of the IBM Unica installer, as described in “How the IBM

Unica Marketing installers work” on page 12
v General IBM Unica Marketing product functionality and components, including

the structure of the file system
v The installation and configuration process for the source product version and for

the new version
v Maintaining configuration properties in your source and target systems
v The installation and configuration process for reports, if you are using these

reports
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Oracle or DB2 only: auto commit requirement
If your Marketing Platform system tables are in Oracle or DB2, you must enable
auto commit for the environment open. See the Oracle or DB2 documentation for
instructions.

Upgrading Schedules with time zone support
In version 8.5.0, the Marketing Platform Scheduler allows you to select any of a
large number of world wide time zones for your tasks. If you had scheduled tasks
in your pre-8.5.0 version of the Marketing Platform, they will be set to the default
time zone, which is the time zone of the server on which the Marketing Platform is
installed.

To take advantage of the time zone support in the Scheduler, you should edit your
scheduled tasks and select the new time zone as needed. See the IBM Unica
Marketing Platform Administrator's Guide for information about using the Scheduler.

If you have re-branded the IBM Unica frameset
If you have re-branded the IBM Unica frameset as described in the IBM Unica
Marketing Platform Administrator's Guide, you must back up the files you modified
before you proceed with the upgrade, and restore them after you have completed
the upgrade installation but before you deploy you new version.

Typically, these files are the corporatetheme.css file and branding images. This file
and the images are located under the css\theme directory within the unica.war file.

Therefore, you should do the following.
1. Make a backup copy of the unica.war file before you start the upgrade

procedure.
2. Extract the unica.war file and set aside copies of your corporatetheme.css file

and branding images.
3. Proceed with the upgrade as described in this chapter, but do not deploy.
4. Extract the new unica.war file and overwrite the existing images and

corporatetheme.css file with your backed-up versions.
5. Re-war the new unica.war file, and deploy.

See the IBM Unica Marketing Platform Administrator's Guide for additional details on
re-branding.
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Marketing Platform upgrade scenarios
Follow these guidelines for upgrading the Marketing Platform.

Source version Upgrade path

Marketing Platform version
before 8.2.0 that is integrated
with an LDAP server

1. If you have mapped LDAP groups in the LDAP references for AM user
creation property that are not mapped in the LDAP reference to AM group
map property, you must do the following when in your current version of
the Marketing Platform before proceeding with the upgrade.

v Identify any groups in the LDAP references for AM user creation
property that are not mapped in the LDAP reference to AM group map
property.

v Map the LDAP groups you have identified to an appropriate Marketing
Platform group. After you perform an LDAP synchronization, you can
map these users to additional Marketing Platform groups to control their
application access as needed. For instructions, see the IBM Unica Marketing
Platform Administrator's Guide.

Performing the previous steps ensures that all desired users are created in
the Marketing Platform.

2. Follow the upgrade procedures for your version, as shown in the remainder
of this table.

Pre-7.5.0 versions of Affinium
Manager

An upgrade from these versions directly to the Marketing Platform is not
supported. Perform the following steps.

1. Obtain the 7.5.1 Affinium Manager software and upgrade to that version.
Important: To upgrade from pre-7.5.0 versions of the Marketing Platform to
version 8.0.0 or later, you must first upgrade to version 7.5.1. The installation
guides packaged with the Manager 7.5.0 and 7.5.1 software contain an error.
If you use either of those guides, you may have problems with the upgrade.
Instead, you must follow the instructions in the corrected Affinium Manager
7.5.1 Installation Guide, which is available on Customer Central or by
contacting IBM Unica Technical Support. (Although the software supports a
direct upgrade from any 7.5.x version to 8.1.x, the upgrade instructions in the
Affinium Manager 7.5.0 Installation Guide have not been corrected. Therefore, if
your version is pre-7.5.0, you must upgrade to version 7.5.1 and use the
corrected instructions.) To ensure that you have the corrected guide, look for
a publication date of July 6, 2010 or later on the title page.

2. Upgrade your 7.5.1 installation of Affinium Manager to the Marketing
Platform, as described in “To upgrade from Manager 7.5.x with automatic
migration” on page 39 or “To upgrade from Manager 7.5.x with manual
migration” on page 40 in this guide.

Affinium Manager version 7.5.x 1. Follow the instructions in “To upgrade from Manager 7.5.x with automatic
migration” on page 39 or “To upgrade from Manager 7.5.x with manual
migration” on page 40 in this guide.

Marketing Platform version 8.x 1. Upgrade your 8.x installation of the Marketing Platform, as described in “To
upgrade from version 8.x with automatic migration” or “To upgrade from
version 8.x with manual migration” on page 34.

To upgrade from version 8.x with automatic migration
Upgrading from version 8.x is an in-place upgrade. You install to the directory
where your current Marketing Platform is installed.

Ensure that you have the following in one directory.
v The IBM Unica master installer
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v The Marketing Platform installer

A best practice is to do the following.
v Place the installers in the same directory where you originally placed the

installers for the earlier versions of your products.
v Remove any earlier versions of the IBM Unica product installers from the

directory, to avoid having the master installer attempt to install the earlier
versions.

v Retain the installer .properties files. This will allow the IBM Unica master
installer to pre-fill many of the fields in the installer wizards.

1. Make a backup copy of your Marketing Platform system table database.

Important: Do not skip this step. If upgrade fails, you will not be able to roll
back your database and your data will be corrupted.

2. Undeploy your Marketing Platform deployment.
Depending on your web application server, you may have deployed a packed
or extracted dashboard.war file and a unica.war file, or you may have deployed
an EAR file containing the Marketing Platform.

3. Run the IBM Unica master installer.
The IBM Unica master installer starts. See “Step: Run the IBM Unica installer”
on page 17 for details on running the installer.
v When the IBM Unica master installer prompts you to choose an installation

directory, choose the root IBM Unica installation directory, not the Marketing
Platform installation directory which is under this IBM Unica directory.

v When the IBM Unica master installer prompts you to enter Marketing
Platform database connection information, enter the information that pertains
to your current Marketing Platform system tables.

The IBM Unica master installer will pause and launch the Marketing Platform
installer.

4. Follow these guidelines in the Marketing Platform installer.
v When the Marketing Platform installer asks whether you want to upgrade

Manager 7.5.x, select No.
v When the Marketing Platform installer prompts you for an installation

directory, select the directory of your current Marketing Platform installation,
usually named Platform.

v Select Automatic database setup.
v Follow all the remaining steps in the installation wizard, entering all

requested information.
5. Deploy your installation following the guidelines in Chapter 5, “Deploying the

IBM Unica Marketing Platform,” on page 21.
6. Pay close attention to the installation summary windows. If errors are reported,

check the installer log files and contact IBM Unica technical support if
necessary.

To upgrade from version 8.x with manual migration
The Marketing Platform upgrade installer can perform all of the data migration
required for an upgrade automatically, but if your company does not allow this,
you must perform this procedure to upgrade manually.
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This procedure applies only to upgrades from Marketing Platform version 8.x. See
“Marketing Platform upgrade scenarios” on page 33 for information on upgrading
from other versions.

Ensure that you have the following in one directory.
v The IBM Unica master installer
v The Marketing Platform installer
v The installers for any product reports packages you want to upgrade

Also, ensure that your installation of Marketing Platform 8.x is fully functional and
that you can run the command line tools. This procedure requires the use of two
Marketing Platform utilities located in the tools/bin directory under your
Marketing Platform installation. Complete information on using these utilities,
including example commands for common tasks, is available as follows.
v “The populateDb utility” on page 91
v “The configTool utility” on page 83
1. Use the configTool utility to export all of your old configuration settings.

The utility is located in the tools/bin directory under your Affinium Manager
installation.
Here is an example command.
configTool -x -f "path_to_any_directory/config_backup.xml"

This command creates a config_backup.xml file in the directory you specified
in the command.
v Verify that the file exists and contains all of your settings.
v Make a note of the file name and location, as you will change the name and

move the file in a later step.
See “The configTool utility” on page 83 for complete usage details.

2. Make a backup of your Marketing Platform system table database.

Important: Do not skip this step. If upgrade fails, you will not be able to roll
back your database and your data will be corrupted.

3. Undeploy your current version.
Depending on your web application server, you may have deployed a packed
or extracted dashboard.war file and a unica.war file, or you may have
deployed an EAR file containing the Marketing Platform. Undeploy both
components if they are deployed separately.

4. Run the IBM Unica master installer.
The IBM Unica master installer starts. Follow these guidelines in the IBM
Unica master installer.
v When the IBM Unica master installer prompts you to enter Marketing

Platform database connection information, enter the information that
pertains to your current Marketing Platform system tables.

v When the IBM Unica master installer prompts you to choose an installation
directory, choose the root IBM Unica installation directory, not the
Marketing Platform installation directory which is under this IBM Unica
directory.

The IBM Unica master installer will pause and launch the Marketing Platform
installer.

5. Follow these guidelines in the Marketing Platform installer.
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v When the Marketing Platform installer prompts you for an installation
directory, select the directory of your current Marketing Platform
installation, usually named Platform.

v When the installer asks whether you want to upgrade Manager 7.5.x, select
No.

v Allow the installer to back up your previous installation.
v Select Manual database setup.
v Deselect the Run Platform configuration checkbox.
v Follow all the remaining steps in the Marketing Platform installer, entering

all requested information.
6. When the reports package installers launch, install the reporting schema

components.
7. Use the configTool utility to perform the following steps to ensure that the

SQL scripts you run in the next step work correctly.
a. Export all of your configuration properties, from the root node Affinium.

For example, the following command exports the properties to a file
named config_property_export.xml, which is written to the install
directory under your Marketing Platform installation. This is a Windows
example.
configTool.bat -x -p "Affinium" -f "C:\Unica\Platform\install\
config_property_export.xml

b. Delete all of the configuration properties, from the root node Affinium.
For example, the following command deletes the properties. This is a
Windows example.
configTool.bat -d -o -p "Affinium"

c. Import the configuration properties you exported.
For example, the following command imports the properties from a file
named config_property_export.xml, located in the install directory under
your Marketing Platform installation. This is a Windows example.
configTool.bat -i -o -f "C:\Unica\Platform\install\
config_property_export.xml

8. After all of the installers finish, use the appropriate table below to locate the
SQL scripts, provided with your new Marketing Platform installation, against
your Marketing Platform system table database. Run the SQL scripts in the
order shown.

Table 1. Use this table if you are upgrading from version 8.0.x

Script Name Location

ManagerSchema_DB_Type_81upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade80to81

ManagerSchema_DB_Type_8201upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade82to8201

ManagerSchema_DB_Type_85upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade82to85

insert_new_85_locales.sql db\upgrade82to85

active_portlets.sql db
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Table 2. Use this table if you are upgrading from version 8.1.x or 8.2.0

Script Name Location

ManagerSchema_DB_Type_8201upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade82to8201

ManagerSchema_DB_Type_85upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade82to85

insert_new_85_locales.sql db\upgrade82to85

active_portlets.sql db

Table 3. Use this table if you are upgrading from version 8.2.0.1

Script Name Location

ManagerSchema_DB_Type_85upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade82to85

insert_new_85_locales.sql db\upgrade82to85

active_portlets.sql db

9. Use the populateDb utility to populate the system tables with default
Marketing Platform configuration properties, users and groups, and security
roles and permissions.
This utility is located in the tools/bin directory under your Marketing
Platform installation.
Example: populateDb -n Manager

See “The populateDb utility” on page 91 for complete usage details.
10. Update the Help > About page, as follows.

a. Use the configTool utility to export the Affinium | Manager | about
category (this category is not visible on the Configuration page, as it is
marked hidden).
Example (Windows): configTool -x -p "Affinium|Manager|about" –f
C:\Unica\Platform\conf\about.xml

b. Edit the exported XML file you just created (about.xml in the example) to
change the version number and display name, as follows.
Find the releaseNumber property and change the value to the current
version of the Marketing Platform. In the example, below, change 7.5.1 to
your new version.
<property name="releaseNumber" type="string">

<displayNameKey>about.releaseNumber</displayNameKey>

<value>7.5.1</value>

</property>

c. Find the displayName property and change the value to the new name of
the product. In the example, below, change Affinium Manager to Marketing
Platform .
<property id="4" name="displayName" type="string_property"
width="40">

<value>Affinium Manager</value>

</property>

d. Use the configTool utility to import the revised file. You must use the –o
option to overwrite the node. Remember that you must specify the parent
node when you import.
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Example (Windows): configTool –i –p “Affinium|Manager” –f
“about.xml” -o

11. Deploy and verify your installation as described in the chapter Chapter 5,
“Deploying the IBM Unica Marketing Platform,” on page 21.
Note that the web component of Reports is no longer a separate deployment.
It is now included in the Marketing Platform and is deployed when you
deploy the EAR file that contains the Marketing Platform.

After you upgrade your IBM Unica Marketing applications, see Chapter 10,
“Upgrading reports,” on page 69 for additional steps required for reporting
upgrades.

About upgrading from Affinium Manager 7.5.x
The installer automatically runs in upgrade mode when you allow it to search for
an installation of Affinium Manager 7.5.x to upgrade.

In upgrade mode, the Marketing Platform installer automatically migrates data
from your existing version of Affinium Manager. See “To upgrade from Manager
7.5.x with automatic migration” on page 39.

If your company policy does not allow you to use the installer to perform the
migration automatically, you can do this manually using the scripts provided with
your Marketing Platform installation. See “To upgrade from Manager 7.5.x with
manual migration” on page 40.

Files generated by automatic migration

The installer exports your Affinium Manager 7.5x configuration to an XML file
named Manager_config_upgrade7xto80.xml. The file is located in the install
directory under your Marketing Platform installation. When you choose automatic
migration, you do not have to do anything with this file during the upgrade
process. When you choose manual migration, you import these settings after you
update the database.

The installer generates an upgrade log named upgrade7xto80.log. The file is
located in the install directory under your Marketing Platform installation.

Additional permissions required for the database user

When you run the installer to upgrade to the Marketing Platform, you must enter
database connection information for the Marketing Platform system table database,
just as you do when you perform a new installation. However, the database
account that you use must have the following rights in addition to the ones listed
in Step: Create the Marketing Platform system table database or schema.
v DROP TABLES
v DROP SEQUENCES (Oracle only)

What happened to Affinium Reports?

In version 8.x, reporting is one of the components provided by the Marketing
Platform. Reporting is no longer provided by a separate web application as it was
with Affinium Reports 7.5.x.

38 IBM Unica Marketing Platform: Installation Guide



When you upgrade Affinium Manager 7.5x to Marketing Platform version 8.x, the
installer and database scripts also upgrade the reporting feature, although some
manual steps may be required. See Chapter 10, “Upgrading reports,” on page 69
for details.

About the All Users group and upgrades

If your installation of Affinium Manager includes a user group named All Users,
this group is migrated to your new installation of the Marketing Platform. Any
application access assignments associated with your All Users group are retained,
except they are called roles in the Marketing Platform.

The only functional difference between the All Users group in Affinium Manager
and the migrated version of this group in the Marketing Platform is that when a
new user is created in the Marketing Platform, that user is not automatically added
to the All Users group.

You can continue to use the All Users group, or you can delete this group. If you
have been relying on this group to provide application access to users and you
delete it, you must provide former members of the group with equivalent roles in
Marketing Platform if you want those users to retain the permissions they had
before you upgraded.

Expected database changes

The following tables are not present in the Marketing Platform after upgrade
because they are no longer used.
v usm_otype
v usm_object
v usm_group
v usm_grp_obj_map
v usm_user_obj_map

In addition, some tables have new names. See the Marketing Platform system table
document for a description of the current Marketing Platform system table
database.

To upgrade from Manager 7.5.x with automatic migration
This procedure applies only to upgrades from Affinium Manager version 7.5.x.

Ensure that you have the following in one directory.
v The IBM Unica master installer
v The Marketing Platform installer
v The installers for any product reports packages you plan to upgrade

Also, ensure that your installation of Affinium Manager 7.5.x is fully functional
and that you can run the command line tools.
1. Use the configTool utility to export all of your old configuration settings.

v The utility is located in the tools/bin directory under your Affinium
Manager installation. See “The configTool utility” on page 83 for complete
usage details.

v Here is an example command.
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configTool -x -f "path_to_any_directory/config_backup.xml"

This command creates a config_backup.xml file in the directory you specified
in the command. Verify that the file exists and contains all of your settings.

2. Make a backup of your Affinium Manager system table database.

Important: Do not skip this step. If upgrade fails, you will not be able to roll
back your database and your data will be corrupted.

3. Undeploy the Affinium Manager WAR file and the Reports WAR file.
4. Run the IBM Unica installer.

v When the IBM Unica master installer prompts you for the installation
directory, you may accept the default, create a new directory, or select any
existing directory. The directory you specify will become the root (parent)
directory for your product installation. Each product you install under this
parent will have its own sub-directory.

v When the IBM Unica master installer prompts you for Marketing Platform
database connection information, enter the information that pertains to your
Affinium Manager 7.5.x system tables.

The IBM Unica master installer will pause and launch the Marketing Platform
installer.

5. Follow these guidelines in the Marketing Platform installer.
v When the Marketing Platform installer asks whether you have a Manager

7.5.x installation that you want to upgrade, select Yes.
v Select your Affinium Manager 7.5.x installation directory as the upgrade

directory.
v Select Automatic database setup.

6. When the reports package wizards launch, install the reporting schema
components.

7. Obtain the database driver and create the JDBC connection to the Marketing
Platform system tables as described in “Step: Configure the web application
server for your JDBC driver” on page 8 and “Step: Create the JDBC connection
in the web application server” on page 9.

8. Deploy and verify your installation.
Note that the web component of Reports is no longer a separate deployment. It
is now included in the Marketing Platform and is deployed when you deploy
the EAR file that contains the Marketing Platform.
Verify your installation as described in “Step: Verify your Marketing Platform
installation” on page 25.

After you upgrade your IBM Unica Marketing applications, see Chapter 10,
“Upgrading reports,” on page 69 for additional steps required for reporting
upgrades.

To upgrade from Manager 7.5.x with manual migration
The Marketing Platform upgrade installer can perform all of the data migration
required for an upgrade automatically, but if your company does not allow this,
you must perform this procedure to upgrade manually.

This procedure applies only to upgrades from Affinium Manager version 7.5.x. See
“Marketing Platform upgrade scenarios” on page 33 for information on upgrading
from other versions.
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Ensure that you have the following in one directory.
v The IBM Unica master installer
v The Marketing Platform installer
v The installers for any product reports packages you want to upgrade

Also, ensure that your installation of Affinium Manager 7.5.x is fully functional
and that you can run the command line tools. This procedure requires the use of
two Marketing Platform utilities located in the tools/bin directory under your
Marketing Platform installation. Complete information on using these utilities,
including example commands for common tasks, is available as follows.
v “The populateDb utility” on page 91
v “The configTool utility” on page 83
1. Use the configTool utility to export all of your old configuration settings.

The utility is located in the tools/bin directory under your Affinium Manager
installation.
Here is an example command.
configTool -x -f "path_to_any_directory/config_backup.xml"

This command creates a config_backup.xml file in the directory you specified
in the command.
v Verify that the file exists and contains all of your settings.
v Make a note of the file name and location, as you will change the name and

move the file in a later step.
See “The configTool utility” on page 83 for complete usage details.

2. Make a backup of your Affinium Manager system table database.

Important: Do not skip this step. If upgrade fails, you will not be able to roll
back your database and your data will be corrupted.

3. Undeploy Affinium Manager WAR file and the Reports WAR file.
4. Run the IBM Unica master installer.

The IBM Unica master installer starts.
v When the IBM Unica master installer prompts you for Marketing Platform

database connection information, enter the information that pertains to your
Affinium Manager 7.5.x system tables. In some cases, the installer cannot
detect your previous Manager installation. In that case, you see an extra
confirmation window asking if you would like to continue. Click OK.

The IBM Unica master installer pauses and launches the Marketing Platform
installer.

5. Follow these guidelines in the Marketing Platform installer.
v When the Marketing Platform installer asks whether you have a Manager

7.5.x installation that you want to upgrade, select Yes.
v When the installer prompts you for an installation directory, select or create

a directory different from your Affinium Manager 7.5.x installation
directory.

v Select Manual database setup.
v Deselect the Run Platform configuration checkbox.
v Follow all the remaining steps in the Marketing Platform installer, entering

all requested information.
6. When the reports package installers launch, install the reporting schema

components.
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7. After all the installers finish, run the following SQL scripts, provided with
your new Marketing Platform installation, against your Affinium Manager
7.5.x system table database. Run the scripts in the order shown in the
following table.

Script Name Location

0_Platform_Upgrade75to80_DropConstraints.sql db\upgrade75to80

1_Platform_Upgrade75to80_DB_Type_backup.sql, where DB_Type is the
database type of your system tables database

db\upgrade75to80

2_Platform_Upgrade75to80_BackupData.sql db\upgrade75to80

ManagerSchema80_DB_Type.sql, where DB_Type is the database type of
your system tables database

db\upgrade75to80

ManagerSchema_DB_Type_81upg.sql, where DB_Type is the database type
of your system tables database

Only if your system table database is SQL Server, you must do one
of the following.

v Open the script and edit it to add GO before and after the CREATE
TABLE statement "CREATE TABLE USM_DB_RESOURCE_BUNDLE(...);".
This part of the script should look like this when you have
completed the edit.

GO

CREATE TABLE USM_DB_RESOURCE_BUNDLE

(

ID BIGINT IDENTITY(1, 1) NOT NULL,

NAME VARCHAR(256) NOT NULL,

LOCALE VARCHAR(16),

APPLICATION INT,

BUNDLE_PROPERTIES VARCHAR(MAX),

PRIMARY KEY CLUSTERED (ID asc)

);

GO

Then run the script.

v Run this script one line at a time rather than all at once.

upgrade80to81

quartz_DB_Type.sql, where DB_Type is the database type of your
system tables database

db

v Only if your system table database is Oracle or DB2, use
3_Platform_Upgrade75to80_CopyDataToNewTables.sql

v Only if your system table database is SQL Server, use
3_Platform_Upgrade75to80_CopyDataToNewTables_SQLServer.sql

db\upgrade75to80

ManagerSchema_DB_Type_8201upg.sql, where DB_Type is the database
type of your system tables database

db\upgrade82to8201

ManagerSchema_DB_Type_85upg.sql, where DB_Type is the database type
of your system tables database

db\upgrade82to85

active_portlets.sql db

8. Do the following with the file that contains your exported configuration
settings that you created in an earlier step. This enables the script to
automatically import your settings in the next step.
v Move or copy the file to the install directory under your new Marketing

Platform installation.
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v Change the name of the file to Manager_config_upgrade7xto80.xml.
9. Run upgrade7xto80 (extension is .bat for Windows and .sh for UNIX). This

script is located in the tools/bin directory under your new Marketing
Platform installation.
If you see an error similar to the following, and your operating system is not
AIX, perform the procedure described in “To obtain the latest JCE policy files”
on page 45 and then run the script.
ERROR com.unica.manager.utils.KeyManager - Cannot retrieve the key from
the file [C:\...\Affinium\Manager\conf\kfile], cause: Illegal key size

10. Run the 4_Platform_Upgrade75to80_Drop7xTables.sql script against your
Affinium Manager 7.5.x system table database.

11. Run the insert_new_85_locales.sql script, located in the db\upgrade82to85
directory under your new Marketing Platform installation, against your
Affinium Manager 7.5.x system table database.

12. Perform the following steps to delete orphan records that could lead to errors
when you run the SQL in the next step.
v Run the following SQL against your Affinium Manager 7.5.x system table

database.
SELECT * FROM USM_ROLE_ROLE_MAP WHERE PARENT_ROLE_ID NOT IN (SELECT
ID FROM USM_ROLE)

SELECT * FROM USM_USER_ROLE_MAP WHERE USER_ID NOT IN (SELECT ID FROM
USM_USER)

v The records returned from these queries are orphan rows. Delete them.
13. Run the ManagerSchema_DB_Type_CreateFKConstraints.sql script against your

Affinium Manager 7.5.x system table database, where DB_Type is the database
type of your system tables database.

14. Use the populateDb utility to populate the system tables with default
Marketing Platform configuration properties, users and groups, and security
roles and permissions. Follow the steps shown here.
This utility is located in the tools/bin directory under your Marketing
Platform installation.
v First, you must edit the script file that runs the utility to increase memory,

as follows.
– Open the populateDb file in a text editor and find the line that looks like

this. The example shown is for Windows. The UNIX version will look
slightly different.
"%JAVA_HOME%\bin\java" -DUNICA_PLATFORM_HOME="
%UNICA_PLATFORM_HOME%" com.unica.manager.tools.PopulateDb %*

– Add -Xmx512m, followed by a space, just before -DUNICA_PLATFORM_HOME.
– Save and close the file.

v Next, run the populateDb utility.
Example: populateDb -n Manager

See “The populateDb utility” on page 91 for complete usage details.
15. Update the Help > About page, as follows.

a. Use the configTool utility to export the Affinium | Manager | about
category (this category is not visible on the Configuration page, as it is
marked hidden).
Example (Windows): configTool -x -p "Affinium|Manager|about" –f
C:\Unica\Platform\conf\about.xml
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b. Edit the exported XML file you just created (about.xml in the example) to
change the version number and display name, as follows.
Find the releaseNumber property and change the value to the current
version of the Marketing Platform. In the example, below, change 7.5.1 to
your new version.
<property name="releaseNumber" type="string">

<displayNameKey>about.releaseNumber</displayNameKey>

<value>7.5.1</value>

</property>

c. Find the displayName property and change the value to the new name of
the product. In the example, below, change Affinium Manager to Marketing
Platform .
<property id="4" name="displayName" type="string_property"
width="40">

<value>Affinium Manager</value>

</property>

d. Use the configTool utility to import the revised file. You must use the –o
option to overwrite the node. Remember that you must specify the parent
node when you import.
Example (Windows): configTool –i –p “Affinium|Manager” –f
“about.xml” -o

16. Obtain the database driver and create the JDBC connection to the Marketing
Platform system tables as described in “Step: Configure the web application
server for your JDBC driver” on page 8 and “Step: Create the JDBC
connection in the web application server” on page 9.

17. Deploy your installation as described in Chapter 5, “Deploying the IBM Unica
Marketing Platform,” on page 21.
Note that the web component of Reports is no longer a separate deployment.
It is now included in the Marketing Platform and is deployed when you
deploy the Marketing Platform.

18. Do the following before going to any other page in IBM Unica Marketing.
v Point your browser to http://host:port/unica/jsp/configmanager.jsp,

where host and port are appropriate values for your installation.
v Log in to IBM Unica Marketing as the asm_admin user.
v Go to the Settings > Configuration page.
v Verify the following configuration values and change them if necessary.

– General > Navigation > Unica URL—This should be the URL for the
Marketing Platform, using a fully qualified host and port. For example,
http://myHost.myCompanyDomain.com:8080/unica.

– Affinium Suite > Domain name—This value must match the domain
used in the Marketing Platform URL, including case. In the above
example, this is myCompanyDomain.com

v Log out.
19. Go to the normal Marketing Platform URL, log in, and verify your installation

as described in “Step: Verify your Marketing Platform installation” on page 25.
20. If you have assigned data sources and data source passwords to any users,

check the data source passwords and re-set them manually, if necessary. You
will definitely have to do this if your operating system is AIX.
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After you upgrade your IBM Unica Marketing applications, see Chapter 10,
“Upgrading reports,” on page 69 for additional steps required for reporting
upgrades.

To obtain the latest JCE policy files
Perform this procedure if you see the following error when you run the
upgrade7xto80 script.

ERROR com.unica.manager.utils.KeyManager - Cannot retrieve the key from the
file [C:\...\Affinium\Manager\conf\kfile], cause: Illegal key size

Note that this workaround does not apply when the Marketing Platform is
installed on AIX. In that case, after you complete the upgrade, you must log in to
IBM Unica Marketing and change data source passwords manually.

This procedure ensures that you have the latest Java Cryptography Extension (JCE)
Unlimited Strength Jurisdiction Policy Files 5.0.

Download these files here: http://java.sun.com/javase/downloads/index_jdk5.jsp

Scroll to Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy
Files 5.0 and do the following.
1. Ensure that the JRE in your Manager 7.5.x installation has the updated JCE

Unlimited Strength Jurisdiction files. Follow instructions in the download to
copy the local_policy.jar and US_export_policy.jar to the jre/lib/security
directory.

2. Use encryptPasswords -k to encrypt your keystore password again.
3. If you are NOT using the JRE provided in the Marketing Platform installer, also

update the JCE Unlimited Strength Jurisdiction files for the JRE you intend to
use.

4. Run the Marketing Platform installer and your keys will be migrated to 8.x.

If the JCE updates are not made, or if you were unable to use the workaround
because your Marketing Platform system table database is AIX, you may see these
errors:

Cannot retrieve the key from the file [<INSTALL_DIR>\Affinium\Manager\conf\
kfile], cause: Illegal key size

javax.crypto.BadPaddingException: pad block corrupted

If these errors occur, when your upgrade is complete, log in to IBM Unica
Marketing and change data source passwords manually.

Upgrading in a clustered environment
Use the following guidelines when you upgrade multiple instances of Affinium
Manager to Marketing Platform in a clustered environment.
v Undeploy all of the instances of Affinium Manager and Affinium Reports.
v Uninstall all instances of Affinium Manager except one.
v Follow the directions in this chapter to upgrade.
v Follow the clustering instructions in Chapter 7, “Installing the IBM Unica

Marketing Platform in a Cluster,” on page 29.
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v For enhanced performance and reliability, you may want to install the JMS
provider Active MQ on a separate machine and perform the task described in
“To install JMS separately from the Marketing Platform” on page 27.
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Chapter 9. Installing Reports

For its reporting feature, IBM Unica Marketing integrates with IBM Cognos® 8 BI,
a third-party business intelligence application. Reporting relies on the following
components:
v An installation of IBM Cognos 8 BI 8.4
v A set of IBM Unica Marketing components that integrate the IBM Unica system

with the IBM Cognos 8 installation
v For Campaign, eMessage, and Interact, reporting schemas that enable you to

build reporting views or tables in the application’s system tables
v The example reports for the IBM Unica Marketing application(s), built with IBM

Cognos Report Studio

The Marketing Platform provides the IBM Unica side of the reporting integration.
To install reporting, you do the following:
v Install the reporting schemas from the application report package on the

machine where the Marketing Platform is installed.
v Set up the reporting views or tables.
v Install the IBM integration components and report models on the IBM Cognos

system.

This chapter describes how to install and set up reporting for your IBM Unica
applications. For information about the individual components and how they
interact with each other, see the IBM Unica Marketing Platform Administrator's Guide.

Install reporting components
Installing and configuring IBM Unica Marketing product report packages is a
multi-step process. Perform the tasks in this section in the order shown to install
reports.

Step: Set up a user with the ReportsSystem role, if necessary
Configure a user with access to the IBM Unica Marketing Settings >
Configuration and Settings > Report SQL Generator pages so you can log in as
this user when you need to configure the reporting properties and generate the
SQL used to create reporting schema.

The easiest way to do this is to assign the ReportSystem role to the
platform_admin user. This role is under Report > PartitionN on the User Roles
and Permissions page.

See “To assign a role to or remove a role from a user” for general information on
performing this task.

To assign a role to or remove a role from a user
1. Click Settings > Users.

The Users page displays.
2. Click the name of the user account that you want to work with.

The user detail page displays a list of the user's attributes, roles, groups, and
data sources.

© Copyright IBM Corp. 1999, 2012 47



3. Click Edit Roles.
The Edit Roles page displays. Roles that are not assigned to the user are shown
in the Available Roles box on the left. Roles that are currently assigned to the
user are shown in the Roles box on the right.

4. Click a role name in the Available Roles box to select it.
The selected role name is highlighted.

5. Click Add or Remove to move the role name from one box to the other..
6. Click Save Changes to save your changes.

A window displays the message, Save Successful.
7. Click OK.

The user details display in the right pane, with your changes shown in the
Roles list.

Step: Install the reporting schemas on the IBM Unica
Marketing system

Use the IBM Unica master installer and the reports package installers to install the
desired reporting schemas on the machine where the Marketing Platform is
installed. See “How the IBM Unica Marketing installers work” on page 12 for
detailed information on the IBM Unica installers.

Follow these guidelines when the reports package installer launches.
1. In the ReportsPackProduct Components window, select Reporting Schema.
2. If more than one option appears in the Schema Type Selection window, it

means that the IBM Unica application has prepackaged custom attributes. Do
one of the following:
a. To install reporting schemas that include the custom attributes, select

Custom. The sample reports for Campaign are configured to use custom
attributes. Therefore, if you are installing the Campaign report package and
you want the sample reports to function correctly, you must select this
option.

b. To install reporting schemas that do not include the custom attributes, select
Base.

The installer places the reporting schema in the file system and registers the
schema with the Marketing Platform.

3. Verify that the reporting schema are registered in the Marketing Platform, as
follows.
a. Log in to the IBM Unica Marketing system as the platform_admin user.
b. Select Settings > Configuration.
c. Expand Reports > Schemas > ProductName.
If you see the schema configuration properties for your application, you
installation is complete.
If the schema configuration properties for your application are not present, the
report package has not been registered, and you must register them manually
as described in the next step.

4. Only if the schema configuration properties are not present, register them
manually as follows.
a. Edit the import_all script and edit it as follows.

The script is located in the tools directory under your reports package
installation.
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Set the value of the MANAGER_TOOLS_BIN_DIR variable to the path of the
tools/bin directory under your Marketing Platform installation.

b. Run the script.
The script invokes the Marketing PlatformconfigTool utility and registers
the schemas.

c. Verify that the schema configuration properties are present.

Step: Determine which authentication mode to configure
The IBM Unica Authentication Provider is one of the components that integrates
the IBM Cognos 8 BI system with IBM Unica Marketing. This component enables
the IBM Cognos 8 BI applications to use IBM authentication to communicate with
the IBM Unica Marketing system as though it were another IBM Unica application
in the suite.

There are three authentication options: anonymous, authenticated, and
authenticated per user.
v Anonymous means authentication is disabled. You use this mode to test your

configuration without the added complication of authentication settings.
v Authenticated means that the communications between the IBM Unica system

and the IBM Cognos system are secured at the machine level. You configure a
single system user and give it with the appropriate access rights. By convention,
this user is named "cognos_admin."

v Authenticated per user means that the system evaluates individual user
credentials.

Determine which authentication mode you need to configure. For a complete
description of these options, see "Reporting and security" in the IBM Unica
Marketing Platform Administrator's Guide.

Step: Create JDBC data sources
The IBM Unica Marketing Reports SQL Generator tool must be able to connect to
the IBM Unica Marketing application databases to generate SQL scripts that create
reporting tables, . The SQL Generator can generate SQL scripts that create views or
materialized views without access to the these application databases, but it cannot
validate the SQL without a data source connection.

In the application server hosting the Marketing Platform, configure a JDBC data
source for each IBM Unica Marketing application for which you want to enable
reporting. Use the default JNDI name listed below. If you do not use the default
JNDI names described in the following tables, make a note of what they are so you
can specify the correct name of the data source when you run the SQL Generator
tool.

IBM application Default JNDI name

Campaign campaignPartition1DS

If there are multiple partitions, create a data source for
each partition.

eMessage campaignPartition1DS for the system tables

eMessagePartition1TrackingDS for the tracking tables
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IBM application Default JNDI name

Interact campaignPartition1DS for the design-time database

InteractRTDS for the runtime database

InteractLearningDS for the learning tables

If you need additional help with this task, see the application server
documentation. See also the section on creating JDBC data sources in the
installation guide for your IBM application.

Optional step: Obtain email server information
If you want report results to be sent through email, obtain the following
information.
v Host name or IP address of your SMTP server
v User name and password for the account on that server
v Email address for the default sender email

Set up the reporting views or tables
To implement reporting for Campaign, eMessage, and Interact, you create
reporting views or tables from which the reports extract reportable data. This
section describes how to run the Reports SQL Generator, which uses the reporting
schemas to generate view or table creation scripts. You then run those scripts on
the IBM Unica application database to create the views or tables.

Configuration checklist: reporting views or tables
The following list provides a high level overview of the steps to perform when
configuring the reporting schemas from an IBM Unica Reports Package. Each step
is described in detail later in this section.
1. “Step: Load the templates for the Reports SQL Generator”
2. “Step: Generate the view or table creation scripts.”
3. “Step: Create the reporting views or tables” on page 51.
4. “Step for tables and materialized views only: Set up data synchronization” on

page 55.

Step: Load the templates for the Reports SQL Generator
The reports packages for IBM Unica Marketing applications that have reporting
schemas contain a SQL script that loads template SQL select statements into the
uar_common_sql table. The Reports SQL Generator uses these templates when
generating the SQL scripts for creating the reporting views or tables. In this task,
you run the script that loads the templates.
1. Navigate to the schema directory under your report pack installation and locate

the templates_sql_load.sql script.
2. Run the templates_sql_load.sql script in the Marketing Platform database.

Step: Generate the view or table creation scripts
Complete the following steps.
1. Log in to IBM Unica Marketing as the platform_admin user (or another user

with access to the Report SQL Generator menu item).
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2. Only if you did not use the default JNDI names for the JDBC data sources
you created in an earlier step, do the following.
a. Select Settings > Configuration > Reports > Schemas > ProductName .
b. Change the default values of the JNDI property to match the JNDI names

you gave the JDBC connections in an earlier step.
3. Select Settings > Reports SQL Generator.
4. In the Product field, select the appropriate IBM application.
5. In the Schema field, select one or more reporting schemas.
6. Select the Database Type.
7. In the Generate Type field, select the appropriate option (views, materialized

views, or tables).
Materialized views are not an option when Database Type is set to MS SQL
Server.
If the JNDI data source names are incorrect or have not been configured, the
SQL Generator cannot validate the SQL.scripts that create tables.

8. Ensure that Generate Drop Statement is set to No.
The first time you run the view or table creation scripts there are no existing
views or tables to drop so there is no need to create drop scripts.

9. (Optional.) To examine the SQL that will be generated, click Generate. The
SQL Generator creates the script and displays it in the browser window.

10. Click Download.
The SQL Generator creates the script and prompts you to specify where you
want to save the file. If you selected a single reporting schema from the
Schema field, the script name matches the name of schema
(eMessage_Mailing_Performance.sql, for example). If you selected more than
one reporting schema, the script name uses the product name only
(Campaign.sql, for example). For a complete list of names, see “SQL script
names and where to run them” on page 52.

11. Specify the location where you want to save the script. If you change the
name of the file, be sure to use something that clearly indicates which
schemas you selected. Then click Save.

12. Repeat steps 5 through 12 for each script you need to generate.

Note: The Interact reporting schemas reference more than one data source.
Generate a separate SQL script for each data source.
There may be times when you want to disable script validation. For example,
perhaps the Marketing Platform cannot connect to the IBM application
database but you want to generate the scripts anyway. To disable validation,
clear the data source names from the data source fields (see step 3, above).
When you generate the scripts, the SQL Generator displays a warning that it
cannot connect to the data source, but it still generates the SQL script.

Step: Create the reporting views or tables
The steps you perform to create views or materialized views are different from
those you perform to create reporting tables. In both cases, however, there are extra
steps when generating views or tables for Interact.

Complete one or more of the following, as appropropriate for your installation.

Refer to “SQL script names and where to run them” on page 52 as necessary.
v “Create views or materialized views for Campaign or eMessage” on page 52
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v “Create views or materialized views for Interact”
v “Create and populate reporting tables for Campaign or eMessage” on page 54
v “Create and populate reporting tables for Interact” on page 54

SQL script names and where to run them
This table shows the system table database or databases where each SQL script
should be run (for views or materialized views). These are the scripts that you
created in a previous step, using the SQL Generator.

Reporting
schema System tables Script name (default names)

All Campaign
reporting
schemas

Campaign system tables Campaign.sql, unless you generate separate
scripts for each reporting schema. If you do,
each script is named after the individual
schema. For example, the default name for
the SQL file generated for the Campaign
Performance schema is
Camapign_CampaignPerformance.sql.

eMessage Mailing
Performance

eMessage tracking tables eMessage_Mailing_ Performance.sql

Interact
Deployment
History, Interact
Performance, and
Interact Views

Campaign system tables Interact.sql

Interact Learning Interact Learning tables Interact_Learning.sql

Interact Run Time Interact run time database Interact_Runtime.sql

Create views or materialized views for Campaign or eMessage
1. Locate the SQL scripts that you generated and saved previously. Refer to “SQL

script names and where to run them” if necessary.
2. Use your database administration tools to run the appropriate script against the

appropriate application database(s) for the report package you are configuring.

Note: When you run a script that creates materialized views on a DB2
database, your database may return the error "SQL20059W The materialized
query table-name may not be used to optimize the processing of queries."
However, the materialized view is successfully created.

3. For Campaign with a DB2 database only, increase the DB2 heap size to 10240
or higher. (The default heap size is 2048.) Use the following command:
db2 update db cfg for databasename using stmtheap 10240

where databasename is the name of the Campaign database.
Increasing the heap size ensures that IBM Cognos does not display SQL error
messages if a user selects all the campaigns when running a report like the
Financial Summary report.

Create views or materialized views for Interact
1. Verify that the language setting of the client from which you will run the

lookup_create SQL script is UTF-8.
For examples of how to do this for Oracle and DB2, see “Setting the language
in Oracle and DB2” on page 53.
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2. Locate the SQL scripts that you generated and saved previously. Refer to “SQL
script names and where to run them” on page 52 if necessary.

3. Use your database administration tools to run the appropriate script against the
appropriate application database(s) for the report package you are configuring.

Note: When you run a script that creates materialized views on a DB2
database, your database may return the error "SQL20059W The materialized
query table-name may not be used to optimize the processing of queries."
However, the materialized view is successfully created.

4. Locate the tools subdirectory in the reports package installation directory and
find the lookup_create script for your database type. For example, the script
for SQL is named uari_lookup_create_MSSQL.sql, and so on.
Run this script on the the Interact design time database. Ensure that the
database tool you are using commits the changes. For example, you may need
to set the database's auto-commit option to true.

5. Locate the db/calendar subdirectory in the Marketing Platform installation
directory and find the ReportsCalendarPopulate script appropriate for the
database type. This script creates two more tables: UA_Calendar and UA_Time.

6. Run this script on the Interact run time database (InteractRTDS).
For DB2 only, do one of the following:
v Either run the script from the command line using the command db2 -td@

-vf ReportsCalendarPopulate_DB2.sql

v Or, if you use the DB2 client interface, change the termination character to
the @ character in the Statement termination character field.

Setting the language in Oracle and DB2:
Oracle example

For example, for Windows and Oracle:
1. Close any open Oracle sessions.
2. Open the Registry Editor.
3. Navigate to HKEY_LOCAL_MACHINE > SOFTWARE > ORACLE and open

the folder for your Oracle Home (ex. KEY_OraDb10g_home1).
4. Search for the NLS_LANG setting.
5. Make sure the last part of the value specified is UTF8. For example:

AMERICAN_AMERICA.UTF8.

DB2 example

For example, for DB2, from the machine that is running the script and has the DB2
client installed, run a DB2 command window. Then run the following command:

db2set

In the output, look for the following variable/value pair: DB2CODEPAGE=1208

If this variable is not set, run the following command

db2 db2set db2codepage=1208

Then close the session window so the change can take effect.
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Create and populate reporting tables for Campaign or eMessage
1. Create the new reporting database.
2. Locate the SQL scripts that you generated and saved previously. Refer to “SQL

script names and where to run them” on page 52 if necessary.
3. Use your database administration tools to run the generated script(s) in the

new database.
4. For Campaign and a DB2 reporting database only, increase the DB2 heap size

to 10240 or higher. (The default heap size is 2048.) Use the following command:
db2 update db cfg for databasename using stmtheap 10240

where databasename is the name of the reporting database.
Increasing the heap size ensures that Cognos does not display SQL error
messages if a user selects all the campaigns when running a report like the
Financial Summary report.

5. Locate the db/calendar subdirectory of the Marketing Platform installation and
find the version of the ReportsCalendarPopulate script appropriate for the
database type. This script creates two more tables: UA_Calendar and UA_Time.

6. Run the ReportsCalendarPopulate script on the new database that you created
with the table creation script.
For DB2 only, do one of the following:
v Either run the script from the command line using the command db2 -td@

-vf ReportsCalendarPopulate_DB2.sql

v Or, if you use the DB2 client interface, change the termination character to
the @ character in the Statement termination character field.

7. Use your database administration tools to populate the new tables with the
appropriate data from the production system database.

Note: Note that you must use your own tools for this step. The SQL Generator
does not generate this SQL for you.

Create and populate reporting tables for Interact
1. Create the new reporting databases.
2. Locate the SQL scripts that you generated and saved previously. Refer to “SQL

script names and where to run them” on page 52 if necessary.
3. Use your database administration tools to run the generated script(s) in the

new database.
4. Locate the db/calendar subdirectory in the Marketing Platform installation

directory and find the lookup_create script for your database type. For
example, the script for SQL Server is named uari_lookup_create_MSSQL.sql,
and so on.
Run this script on the tables that represent the Interact design time database.
Ensure that the database tool you are using commits the changes. For example,
you may need to set the database's auto-commit option to true.

5. Locate the db/calendar subdirectory in the Marketing Platform installation
directory and find the ReportsCalendarPopulate script appropriate for the
database type. This script creates two more tables: UA_Calendar and UA_Time.

6. Run this script on both the set of tables that represents the Interact design time
database and the tables that represent the Interact run time database.
For DB2 only, do one of the following:
v Either run the script from the command line using the command db2 -td@

-vf ReportsCalendarPopulate_DB2.sql
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v Or, if you use the DB2 client interface, change the termination character to
the @ character in the Statement termination character field.

7. Use your database administration tools to populate the new tables with the
appropriate data from the production system database.

Note: Note that you must use your own tools for this step. The SQL Generator
does not generate this SQL for you.

Step for tables and materialized views only: Set up data
synchronization

If you created materialized views, be sure to use your database administration
tools to schedule regular data synchronization between the production databases of
the IBM Unica Marketing application and the materialized views.

If you created reporting tables, be sure to use scheduled ETL (Extraction,
Transformation and Load) or any custom method to schedule regular data
synchronization, between the the production databases of the IBM Unica
Marketing application and the new reporting tables.

Install and test IBM Cognos 8 BI
If your license agreement with IBM Unica grants you an IBM Cognos 8 BI license,
you can download the IBM Cognos 8 BI 8.4 installation media from IBM Unica 's
Customer Central web site.

IBM Cognos 8 BI, IBM Unica reporting, and domains
Before you begin, determine whether you are installing IBM Cognos 8 BI in the
same domain as the IBM Unica Marketing suite. As a best practice, you are
strongly encouragedto install IBM Cognos and the IBM Unica Marketing system in
the same domain. If you do not, you must configure both IBM Cognos and IBM
Unica Marketing to use SSL.

Note: After you install IBM Cognos 8, be sure to use Cognos Configuration to
configure the Cognos URLs appropriately. On a Windows system, the default
values for these URLs use the machine name "localhost." You must replace the
"localhost" placeholder with the fully qualified host name, including domain.

IBM Cognos 8 BI applications
IBM Cognos 8 BI is a collection of several applications, servers, and services,
organized in a multi-tiered architecture. When you use IBM Cognos BI with your
IBM Unica Marketing suite, you use the following subset of the Cognos 8 BI
applications:
v IBM Cognos 8 BI Server, which provides storage for reports and folders (plus

the queries and metadata models), the Content Manager, and so on.
v IBM Cognos Connection, a web application that you use to import, configure,

and schedule the reports. This application also provides access to the following
additional components:
– Cognos Viewer - used for displaying reports. This is the module that displays

the reports in your IBM Unica Marketing applications.
– Report Studio - used for customizing reports and creating new ones. Note

that when you purchase IBM Cognos 8 BI from IBM Unica , you are typically
granted a license for one report author only.

– Cognos Administration - used for configuring data sources and so on.
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v IBM Cognos Framework Manager - the metadata modeling tool that you use to
configure and customize the Cognos data model that supports the IBM Cognos 8
BI reports for your IBM Unica application.

v IBM Cognos Configuration - the configuration tool that you use to configure
individual Cognos 8 BI components.

IBM Cognos 8 BI installation options and Cognos
documentation

Before you install IBM Cognos 8 BI, use the IBM Cognos 8 BI Architecture and
Deployment Guide to learn about the various components, the installation options,
and the configuration approaches recommended by IBM Cognos.

The IBM Cognos documentation uses two general categories to describe
installations: installing in a distributed environment vs. installing all the
components on one computer. For best results, do not install all components on
one computer unless it is for a proof of concept or is a demonstration environment.

Installing the subset of IBM Cognos 8 BI applications that IBM Unica reporting
uses requires that you use two IBM Cognos installers. One provides the IBM
Cognos 8 BI server, the Content Manager, Cognos Configuration, and the
Web-based user interfaces. You use a separate installer to install Framework
Manager, the metadata modeling tool, because it must be installed on a Windows
machine.

If you are installing all components on one computer you can use the IBM Cognos
8 Quick Start Installation and Configuration Guide. If you are installing in a
distributed environment, use the full installation guide, IBM Cognos 8 BI Installation
and Configuration Guide.

IBM Cognos 8 BI web applications and the web server
IBM Unica does not provide the web server that hosts Cognos Connection and the
other IBM Cognos 8 BI web applications. For Windows, the IBM Cognos
documentation assumes that you are using Microsoft's IIS (Internet Information
Services) but you can also use Apache HTTP.

If you use the Apache HTTP server, take care to set up the web aliases for the
Cognos web applications in the VirtualHost configuration directive of the Apache
httpd.conf file correctly: be sure to order the most specific alias first (the script
alias) and set directory permissions for each alias.

Example httpd.conf code snippet

The following example is from an Apache installation on a Windows system and
the Apache server is running on the default port 80.

<VirtualHost *:80>
ScriptAlias /cognos8/cgi-bin "C:/cognos/cgi-bin"

<Directory "C:/cognos/cgi-bin">
Order allow,deny
Allow from all

</Directory>
Alias /cognos8 "C:/cognos/webcontent"

<Directory "C:/cognos/webcontent">
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Order allow,deny
Allow from all

</Directory>
</VirtualHost>

Note: This httpd.conf file snippet is an example, only. Be sure to configure your
web aliases appropriately for your systems.

IBM Cognos 8 BI and locale
If you plan to install a localized version of your IBM Unica application report
package (other than English), be sure to set the product locale to match the
language of the application report package.

On the system running the Cognos Content Manager, open Configuration Manager,
select Actions > Edit Global Configuration, and configure the locale for the IBM
Cognos 8 BI system. For more information, see the IBM Cognos Configuration User
Guide, available from the Help menu in Configuration Manager.

Test the IBM Cognos 8 BI installation
Test your IBM Cognos installation using the following guidelines.
v Stop and restart the Cognos 8 BI server and check the cogserver.log file for

errors. The file is located in the logs directory of your Cognos installation.
v Verify that database tables exist in the Cognos content store. There should be

approximately 134 tables.

If you have a distributed Cognos environment with components installed on
different machines, for example Cognos 8 BI server on a UNIX system and
Framework Manager installed on a Windows machine, do the following.
v Verify that you can communicate with the internal and external dispatcher and

the Content Manager from the machine where the Gateway is installed. To test
components that do not have a user interface, enter the URI of the component in
a browser’s address field. A Cognos page should appear in the browser.

v Open Framework Manager and start to create a new project. This test ensures
that you can log in. Check the log file again for errors.

Install IBM Unica Marketing integration components and report models
on the Cognos system

To integrate the IBM Unica Marketing suite with Cognos, you need the following
installers.
v The IBM Unica Marketing master installer—You always run this installer to

launch the other installers
v The Marketing Platform installer—You install the Cognos integration component

from this installer
v The reports pack installer or installers for the products for which you want to

implement reporting—You install the reports archive containing the models and
sample reports from this installer

After you perform the installation, you perform the following configuration steps,
as described in the remainder of this section.
v Configure IBM Unica Marketing and Cognos reporting properties in the

Marketing Platform interface
v Import the report into Cognos Connection
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v Configure Cognos to use IBM Unica Marketing authentication

Installation checklist: IBM Cognos integration
The following list provides a high level overview of how to install and configure
the IBM Unica components and reports on the IBM Cognos system. Each step is
described in detail later in this section.
1. “Step: Obtain the JDBC driver for the Marketing Platform system tables.”
2. “Step: Install the reporting models and integration component on the IBM

Cognos system.”
3. “Step: Create the IBM Cognos data sources for the IBM Unica application

databases” on page 59.
4. “Optional step: Set up email notification” on page 60.
5. “Step: Configure the IBM Cognos application's firewall” on page 60.
6. “Step: Import the reports folder in Cognos Connection” on page 61.
7. “Step: Configure and publish the data model, if necessary” on page 61.
8. “Step: Enable internal links in the reports” on page 62.
9. “Step: Verify the data source names and publish” on page 63.

10. “Step: Configure the reporting properties in IBM Unica Marketing” on page
63.

11. “Step: Test your configuration without authentication enabled” on page 64.
12. “Configure IBM Cognos to use IBM Unica Marketing authentication” on page

64.
13. “Step: Test your configuration with authentication configured” on page 67.

Step: Obtain the JDBC driver for the Marketing Platform
system tables

Obtain the JDBC drivers and any required associated files that you used to
configure the JDBC data source for the Marketing Platform's system tables when
you set up the IBM Unica Marketing system. In a task later in this chapter, you
configure Cognos to use IBM Unica Marketing authentication. Cognos needs the
JDBC driver so it can obtain user information from the Marketing Platform system
tables when it uses IBM Unica Marketing authentication.

Copy the JDBC driver to the machine where the Cognos Content Manager is
installed, to the webapps\p2pd\WEB-INF\AAA\lib directory under your Cognos
installation.

Step: Install the reporting models and integration component
on the IBM Cognos system

If yours is a distributed Cognos installation, determine which machine is running
the Cognos Content Manager so you can run the IBM Unica installer on this
machine.
1. Stop the IBM Cognos service.
2. On the machine where the Cognos Content Manager is installed, place the

following IBM Unica installers in a single directory.
v IBM Unica master installer
v Marketing Platform
v The reports pack installer or installers for the products for which you want

to implement reporting
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3. Run the IBM Unica master installer, and select the Marketing Platform and
Reports packages you want to install.

4. Following the prompts, enter the connection information for the Marketing
Platform system table database.

5. When the Marketing Platform installer launches and the Platform Installation
Components window appears, select the Reports for IBM 8 Cognos BI option
and clear the other options

6. When the Marketing Platform installer prompts for the path to the JDBC driver,
enter the fully qualified path for the JDBC driver you copied to the Cognos
system during the task “Step: Obtain the JDBC driver for the Marketing
Platform system tables” on page 58.

7. When the Marketing Platform installer prompts for the location of the IBM
Cognos installation, enter or browse to the top level of the IBM Cognos
installation directory. Note that the default value provided in this field is a
static value that is not based on the actual file structure of your IBM Cognos
system.

8. When the report pack installer or installers displays installation options, select
the IBM Cognos Package for Product, and clear the option for the reporting
schemas.
This option copies the reports archive to the Cognos machine. You import this
archive later.

9. Restart the IBM Cognos server.

Step: Create the IBM Cognos data sources for the IBM Unica
application databases

The IBM Cognos applications need their own data sources that identify the IBM
Unica application databases – that is, the source of the data for the reports. The
IBM Cognos data models provided in the IBM Unica reports packages are
configured to use the following data source names:

Table 4. Cognos data sources

IBM Unica application Cognos data source name(s)

Campaign CampaignDS

eMessage eMessageTrackDS

Interact InteractDTDS for the design time database

InteractRTDS for the runtime database

InteractLearningDS for the learning database

Marketing Operations MarketingOperationsDS

Leads LeadsDS for the data mart tables

Use the following guidelines to create Cognos data sources for the IBM application
databases:
v Use the Administration section of Cognos Connection.
v Use the default data source names that are shown in the Cognos data sources

table. That way you can avoid altering the data model.
v The database type you select must match that of the IBM application database.

Use the Cognos documentation and help topics to determine how to fill out
database-specific fields.
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v Be sure that you identify the IBM Unica application database and not the
Cognos content store.

v When you configure the Signon section, select the Password and Create a
Signon that the Everyone group can use options.

v In the Signon section, specify the user credentials for the IBM Unica application
database user.

v Consult the Cognos data sources table and ensure that you create all the data
sources required by the data model for the reports you are configuring. For
example, the reporting data for Interact is located in three databases so you must
create separate Cognos data sources for each one.

v If the Campaign system has more than one partition, create separate data
sources for each partition. For example, if Campaign is configured for multiple
partitions, create a separate Campaign data source for each partition.

v Verify that you have configured each data source correctly by using the Test
Connection feature.

If you have any questions about configuring Cognos data sources, see the IBM
Cognos 8 Administration and Security Guide, "Chapter 6: Data Sources and
Connections" and the Cognos online help.

Optional step: Set up email notification
When an IBM Cognos report is displayed in the IBM Unica Marketing interface,
the Cognos Viewer toolbar in the window includes an option for sending the
report as an attachment in an email. If you want to enable IBM Cognos to send
IBM Unica Marketing reports as email attachments, configure notification in
Cognos Configuration.

Use the following guidelines to set up email notification for the IBM Unica
Marketing application reports:
v In Cognos Configuration, select Data Access > Notification.
v Specify the SMTP mail server using the host name or the IP address plus the

port using the format host:port or IPAddress:port. For example, serverX:25 or
192.168.1.101:25. (The default SMTP port is usually 25.)

v To set the user name and password of the account, click in the Value column
and click the pencil icon to open the Value dialog box.

v Specify the default sender using the pattern user@company.com.

If you have any questions about configuring email notification, see the Cognos
Connection online help.

Note: When a user selects the email option from the Cognos Viewer toolbar, the
email form that appears includes the option to insert a link to the report. When
you acquire your IBM Cognos license from IBM Unica Marketing, this option is
not supported. Users can send the reports as email attachments only.

Step: Configure the IBM Cognos application's firewall
To configure the IBM Cognos firewall, you specify the IBM Unica Marketing
system as a valid domain or host and disable validation.
1. In Cognos Configuration, select Security > IBM Cognos Application Firewall.
2. Set Enable CAF validation to false.
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3. In the valid domains or hosts property, enter the fully qualified machine host
name, including the domain and the port, for the system where the Marketing
Platform is running.

Important: If you have a distributed IBM Unica Marketing environment, you
must do this for every machine on which an IBM Unica Marketing product that
renders Cognos reports is installed (for example, the Marketing Platform, which
has dashboards; Campaign; and Marketing Operations).
For example:
serverXYZ.mycompany.com:7001

4. Save the configuration.
5. Restart the IBM Cognos service.

Step: Import the reports folder in Cognos Connection
The IBM Unica application reports are in the zip file the report package installer
copied to the IBM Cognos machine. Use the guidelines in this procedure to import
the reports zip file into Cognos Connection.
1. Navigate to the Cognos8 directory under your report package installation on

the IBM Cognos machine.
2. Copy the reports archive .zip file (for example Unica Reports for

Campaign.zip) to the directory where your Cognos deployment archives are
saved. In a distributed IBM Cognos environment, this is a location on the
system running the Content Manager.
The default location is the deployment directory under your IBM Cognos
installation and it is specified in the Cognos Configuration tool installed with
the Cognos Content Manager. For example: cognos\deployment.

3. Locate the Cognos8\ProductNameModel subdirectory under your report package
installation on the Cognos machine.

4. Copy the entire subdirectory to any place on the system running Cognos
Framework Manager that Framework Manager has access to.

5. Open Cognos Connection.
6. From the Welcome page, click Administer Cognos Content.

If your Welcome page is turned off, turn it back on in the Cognos Connection
user preferences.

7. Click the Configuration tab.
8. Select Content Administration.

9. Click New Import on the toolbar .
10. Follow these guidelines as you step through the New Import Wizard:

a. Select the reports archive that you copied in the previous procedure.
b. In the Public folders content list, select all the options, including the

package itself (the blue folder).
c. If you do not want users to access the package and its entries yet, select

Disable after import. You do this when you want to test the reports before
you make them available to the IBM Unica application users.

Step: Configure and publish the data model, if necessary
In “Step: Create the IBM Cognos data sources for the IBM Unica application
databases” on page 59, you set up the IBM Unica Marketing system tables as a
Cognos data source. If the data source login you used is not the owner of the IBM
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Unica Marketing application system tables, perform the step described here. If the
data source login you used does own the IBM Unica Marketing application system
tables, then you can skip this step.
1. Locate the Model directory under the reports package installation. Copy all of

the files in this Model directory to anywhere under your Cognos Framework
Manager installation directory. These files constitute the application-specific
data model.

2. In Framework Manager, open the project file. The project file has a .cpf
extension and the file name includes the IBM Unica Marketing application
name (for example, ProductNameModel.cpf).

3. Open the data model for the application and do the following.
a. In the Project Viewer, expand Data Sources.
b. Click the data source for the application.
c. Update the data source as described in the following table.

Database Fields

SQL Server v Catalog: Enter the name of the IBM Unica Marketing application
database.

v Schema: Enter the name of the IBM Unica Marketing application
database schema. For example, dbo

Oracle v Schema: Enter the name of the IBM Unica Marketing application
database schema.

DB2 v Schema: Enter the name of the IBM Unica Marketing application
database schema.

4. Save and republish the package.
If you need basic instructions on publishing a package in IBM Cognos, see the
Cognos Framework Manager User Guide.

Step: Enable internal links in the reports
The IBM Unica Marketing application reports have standard links. To enable these
links to work properly, you must configure the Cognos firewall as described in
“Step: Configure the IBM Cognos application's firewall” on page 60, and you must
configure the redirect URL in the Cognos data model (the .cpf file) for the IBM
Unica Marketing application reports, as follows.
1. From Cognos Framework Manager, browse to the <productName>Model

subdirectory you copied into the Framework Manager directory structure and
select the .cpf file. For example, CampaignModel.cpf.

2. Select Parameter Maps > Environment.
3. Right click Environment and select Edit Definition.
4. In the Redirect URL section, select the Value field. Edit the server name and

port number so they are correct for the IBM Unica Marketing system, leaving
the rest of the URL intact. By convention, the host name includes the domain
name.
For example, for Campaign:
http://serverX.ABCompany.com:7001/Campaign/
redirectToSummary.do?external=true&

For example, for Marketing Operations:
http://serverX.ABCompany.com:7001/plan/callback.jsp?

5. Save the model and publish the package:
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a. From the navigation tree, expand the Packages node of the model.
b. Right click the package instance and select Publish Package.

Step: Verify the data source names and publish
When you publish the model from Framework Manager to the Cognos content
store, the name specified as the data source for the reports in the model must
match the name of the data source you created in Cognos Connection. If you used
the default data source names as described in “Step: Create the IBM Cognos data
sources for the IBM Unica application databases” on page 59, the data source
names match. If they do not, you must change the name of the data source in the
model.
1. In Cognos Connection, determine the names of the data sources you created.
2. In Framework Manager, select the Open a Project option.
3. Browse to the <productName>Model subdirectory you copied into the Framework

Manager directory structure and select the .cpf file. For example,
CampaignModel.cpf.

4. Expand the Data Sources entry and examine the names of the data sources.
Verify that they match what you named them in Cognos Connection.
a. If they match, you are finished with this procedure.
b. If they do not match, select the data source instance and edit the name in

the Properties section. Save your changes.
5. Publish the package to the Cognos content store

Step: Configure the reporting properties in IBM Unica
Marketing

There are several sets of properties for configuring reporting in IBM Unica
Marketing. Some specify parameter values for the reporting components in the
Marketing Platform and some specify URLs and other parameters for the IBM
Cognos 8 BI system.
1. Log in to IBM Unica Marketing as the platform_admin user or another user

with the ReportsSystem role.
2. Select Settings > Configuration > Reports > Integration > Cognos 8

3. Set the value of the Enabled property to True.
4. Set the value of the Domain property to the name of the company domain on

which the IBM Cognos system is running.
For example, xyzCompany.com.
Note that if your company uses subdomains, the value in this field should
include the company domain and the subdomain.

5. Set the value of the Portal URL property, to the URL of the Cognos Connection
portal. Use a fully qualified host name, including the domain and any
subdomains (specified in the Domain property).
For example: http://MyCognosServer.xyzCompany.com/cognos8/cgi-bin/
cognos.cgi

You can find this URL in the Cognos Configuration utility under Local
Configuration > Environment.

6. In the Dispatch URL field, specify the URL of the primary Cognos Content
Manager dispatcher. Use a fully qualified host name, including the domain and
any subdomains (specified in the Domain property).
For example: http://MyCognosServer.xyzCompany.com:9300/p2pd/servlet/
dispatch
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You can find this URL in the Cognos Configuration utility under Local
Configuration > Environment.

7. Leave Authentication mode set to anonymous for now.
8. Save the settings.

Step: Test your configuration without authentication enabled
After the reports are installed and configured but before you enable authentication,
test the setup by running some reports.
1. Verify that IBM Unica Marketing is running and that the IBM Cognos 8 BI

service is running.
2. Log in to IBM Unica as a user with application access and create some data.

(Otherwise the reports have nothing to show.)
3. Open Cognos Connection.
4. Navigate to the report folders you imported and click the link to a basic report.

For example, for Campaign, select Public Folders > Campaign > Campaign >
Campaign Summary.
If the report fails, verify that you configured the Cognos data source for the
IBM Unica application database correctly. See “Step: Create the IBM Cognos
data sources for the IBM Unica application databases” on page 59.

5. Click a link in the report.
If the internal links from the reports do not work, the redirect URL is not
configured correctly. See “Step: Enable internal links in the reports” on page 62.

6. Log in to the IBM Unica application as a user with application access and
navigate to the Analysis page.
When you specify the URL for the IBM Unica application, be sure to use a fully
qualified host name with your company domain (and subdomain, if
appropriate). For example:
http://serverX.ABCompany.com:7001/unica

7. Click the link to the same report that you tested in Cognos.
If you cannot view the report, it is likely that the IBM Cognos firewall is not
configured correctly. See “Step: Configure the IBM Cognos application's
firewall” on page 60.

8. Click a link in the report.
If the internal links from the reports do not work, the redirect URL is not
configured correctly. See “Step: Enable internal links in the reports” on page 62.

9. Open an individual item, click the Analysis tab, and verify that the report is
correct.

Configure IBM Cognos to use IBM Unica Marketing
authentication

The IBM Unica Marketing Authentication Provider enables the Cognos applications
to use IBM Unica Marketing authentication to communicate with the IBM Unica
Marketing system as though it were another IBM Unica Marketing application in
the suite.

Before you begin the procedures in this section, be sure that you know which
authentication mode you plan to configure ("authenticated" or "authenticated per
user). If you need more information, see “Step: Determine which authentication
mode to configure” on page 49.
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Step: Create the reporting system user, if necessary

Note: If you are setting the authentication mode to "authenticated per user" skip
this procedure and continue to “Step: Configure the Cognos authentication
properties in IBM Unica Marketing.”

When you create the reports system user, you create the user and add data source
credentials to the user that holds login information for IBM Cognos 8 BI. In this
way, you configure two sets of logins for the same user:
v One for the IBM Unica system: the user name and password specified for the

reports system user (cognos_admin)
v One for IBM Cognos 8 BI: the user name and password specified as data source

credentials for the reports system user
1. Log in to IBM Unica Marketing as the platform_admin user.
2. Select Settings > Users.
3. Create a new IBM Unica user with the following attributes:

a. User name: cognos_admin
b. Password: admin

4. Create a new data source for the user with the following attributes:
a. Data Source: Cognos
b. Data Source Logon: cognos_admin

Ensure that the user name in the data source exactly matches the user name
of the IBM Unica user you created in step 3.

c. Data Source Password: admin
5. Add the Reports System role to the user.
6. If IBM Unica Marketing is configured to expire user passwords, log out and

then log back in as the reporting system user (cognos_admin). This step
ensures that you interact with the IBM Unica security "change password"
challenge and reset the password before you log in to IBM Cognos as this user
in a later task.

Step: Configure the Cognos authentication properties in IBM
Unica Marketing
1. Log in to IBM Unica Marketing as the platform_admin user.
2. Select Settings > Configuration.
3. Expand Reports > Integrations > Cognos 8.
4. Set the value of the Authentication Mode property by selecting either

authenticated or authenticatedPerUser, as appropriate for your system.
5. For "authenticated" only. Verify that the values in the Authentication user

name and Authentication datasource name fields match those of the user and
data source you created in the previous task, “Step: Create the reporting system
user, if necessary.”

6. If the IBM Cognos installation and the IBM Unica installation are not in the
same domain, change the value in the Enable form authentication property to
true, which means that IBM Unica security should use form-based
authentication in place of cookies.

Important: When the Enable form authentication property is set to true, the
login name and password appended to the Cognos URL appear as clear text
unless IBM Unica Marketing and IBM Cognos are configured to use SSL
communication. Even with SSL configured, the user name and password
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appear as clear text in the HTML source code when you "view source" in a
displayed report. For this reason, you should install IBM Cognos and IBM
Unica Marketing in the same domain.

7. Save the new settings.
8. For "authenticatedPeruser" only. Assign the ReportUser role to the default

asm_admin user. You do this because to test reports, you need a user with
access to the IBM Unica application and with access to the report data. The
platform_admin user does not have access to the IBM Unica application
features.

Step: Configure IBM Cognos to use the IBM Unica Authentication
Provider
In this task, you use the Cognos Configuration and Cognos Connection
applications to configure the IBM Cognos 8 BI 8.4 applications to use the IBM
Unica Authentication Provider.
1. On the machine running the Cognos Content Manager, open Cognos

Configuration
2. Select Local Configuration > Security > Authentication.
3. Right-click Authentication and select New resource > Namespace.
4. Complete the fields as follows, and then click OK:

a. Name: Unica
b. Type: Custom Java Provider.

5. On the Resource Properties page, complete the fields as follows and then save
your changes:
a. NamespaceID: Unica
b. Java class name:

com.unica.report.adapter.UnicaAuthenticationProvider

6. Stop and restart the IBM Cognos 8 BI service.
On a Windows system, sometimes the Cognos interface indicates that the
service is stopped when it is not. To ensure that the service has really stopped,
use the Windows Administrative tools to stop the service.

7. Under Local Configuration > Security > Authentication, right-click Unica
and select Test.
If Cognos Connection displays an error, examine the cogserver.log file,
located in the logs directory of your Cognos installation to determine the
problem.

8. Log in to Cognos Connection as follows to verify that the IBM Unica
Authentication provider is configured correctly:
v If you set the authentication mode to "authenticated," log in as the

cognos_admin (report system) user.
v If you set the authentication mode to "authenticated per user," log in as the

asm_admin user.
If IBM Cognos displays the error "The 3rd party provider returned an
unrecoverable exception," expand the error message. If it states "invalid
credentials," you made an error entering your user credentials. Try again.
However, if it states "password expired," IBM Unica Marketing expired the
password. Log in to IBM Unica application as the reporting system user and
reset the password. Then try logging in to Cognos Connection again.
If you still cannot log in to Cognos Connection, examine the cogserver.log
file, located in the logs directory of your Cognos installation, to determine the
problem.
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9. When you can successfully log in to Cognos Connection, open Cognos
Configuration again.

10. Select Local Configuration > Security > Authentication > Cognos.
11. Disable anonymous access to IBM Cognos by setting Allow anonymous

access? to false.
12. Save your changes.
13. Stop and restart the IBM Cognos service.

If the IBM Cognos service cannot communicate successfully with the
authentication provider, it cannot start. If the IBM Cognos service fails to start,
verify your configuration by retracing the steps in this procedure.

14. Distributed systems only. If your IBM Cognos system has backup Content
Managers configured for failover support, repeat this procedure on all the
servers with Content Manager installed.

At this point, anyone logging in to an application on the Cognos system must be
authenticated by IBM Unica Marketing. Additionally, the authentication namespace
"Unica" now appears in the IBM Cognos user interface for logon and security
administration tasks.

Step: Test your configuration with authentication configured
After configuring IBM Cognos to use IBM Unica authentication, test the system
again.
1. Verify that IBM Unica Marketing is running and that the IBM Cognos service is

running.
2. Open Cognos Connection.
3. Navigate to the report folders you imported and click the link to a basic report.

For example, for Campaign, select Public Folders > Campaign > Campaign >
Campaign Summary.
If the report fails, verify that you configured the IBM Cognos data source for
the IBM Unica application database correctly. See “Step: Create the IBM Cognos
data sources for the IBM Unica application databases” on page 59.

4. Click a link in the report.
If the internal links from the reports do not work, the redirect URL is not
configured correctly. See “Step: Enable internal links in the reports” on page 62.

5. Log in to IBM Unica Marketing and navigate to the Analysis page.
When you specify the URL for the IBM Unica application, be sure to use a fully
qualified host name with your company domain (and subdomain, if
appropriate). For example:
http://serverX.ABCompany.com:7001/unica

6. Click the link to the same report that you tested in IBM Cognos.
If you see error messages about security, it is likely that the IBM Unica
Authentication Provider is not configured correctly. See “Configure IBM Cognos
to use IBM Unica Marketing authentication” on page 64.
If you are prompted to enter credentials for authentication, it is likely that the
domain name is missing from one of your URLs. Log in to IBM Unica
Marketing as a user with admin privileges. Then select Settings >
Configuration and ensure that the URLs in the following properties include the
domain name and any appropriate subdomain name.
v Reports > Integration > Cognos > Portal URL and Dispatch URL
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v Any URL properties for the IBM Unica applications, for example: Campaign
> navigation > serverURL

7. Click a link in the report.
If you are prompted to enter credentials for authentication, it is likely that the
domain name is missing from one of the URLs.

8. Open an individual item, click the Analysis tab, and verify that the report is
correct.
If you see error messages about security, it is likely that the IBM Unica
Application Provider is not configured correctly.

Next steps for reporting
At this point, reporting is working properly and the example reports are in their
default state. When you finish configuring the actual data design of your IBM
Unica Marketing applications - things like campaign codes, custom campaign
attributes, response metrics, and so on - you will return to reporting because you
may need to customize the reports or reporting schemas.
v If you are using Campaign or Interact, see the "Configuring reporting" chapter in

the Marketing Platform Administrator's Guide.
v If you are using Marketing Operations, see the "Using Reports" chapter in the

IBM Unica Marketing Operations Administrator's Guide.
v If you are setting up reporting for eMessage, you are done configuring

reporting. You cannot customize the eMessage reporting schemas or the reports.
v If you configured the system to use the "authenticated per user" mode, ensure

that the appropriate IBM Unica Marketing users can run the reports from the
IBM Unica Marketing applications. The easiest way to do this is to assign the
default ReportsUser role to the appropriate user groups or users, as described in
“To configure report folder permissions.”

To configure report folder permissions
In addition to controlling access to the Analytics menu item and the Analysis tabs
for object types (campaigns and offers, for example), you can configure
permissions for groups of reports based on the folder structure in which they are
physically stored on the IBM Cognos system.
1. Log in as a Campaign administrator who has the ReportSystem role.
2. Select Settings > Sync Report Folder Permissions.

The system retrieves the names the folders located on the IBM Cognos system,
for all partitions. (This means that if you decide to configure folder permissions
for any partition, you must configure it for all of them.)

3. Select Settings > User Permissions > Campaign.
4. Under the Campaign node, select the first partition.
5. Select Add Roles and Assign Permissions.
6. Select Save and Edit Permissions.
7. On the Permissions form, expand Reports.

The Reports entry does not exist until after you run the Sync Report Folder
Permissions option for the first time.

8. Configure the access settings for the report folders appropriately and then save
your changes.

9. Repeat steps 4 through 8 for each partition.
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Chapter 10. Upgrading reports

In IBM Unica Marketing version 8.x, reporting is one of the components provided
by the Marketing Platform. That is, IBM Unica reporting is no longer provided in a
separate web application as it was in Affinium Reports 7.5.x.

When you upgrade to Marketing Platform version 8.x, the installer and database
scripts also upgrade the reporting feature, retaining the configuration settings for
the Campaign and Interact reporting schemas. This chapter describes how to
upgrade and configure the other reporting components.

About upgrading from version 7.5.1

When you install the IBM Cognos reports archive from the reports package, you
run an upgrade script that preserves your customizations to the Cognos data
model, but you must replace the 7.5.1 reports with the new reports. Although the
majority of the older reports are compatible with the upgraded Cognos models, the
8.x reports packages include new and enhanced reports, and most of the packages
also contain Dashboard reports. The only way to obtain the new or enhanced
reports is to install the 8.x reports archive, which overwrites the existing reports.

Therefore, you have two options for upgrading your reports.
v Back up the old reports, install the new reports, and then recreate your

customizations using the old reports for reference.
v Back up the old reports and install the new reports. Compare the new reports to

your old reports and examine your customizations. If you are certain that a
customized report will function properly with the new data model, copy the old
customized report back into the reports folder.

Note that the 7.5.1 version of the Campaign Performance by Cell reports and the
Offer Performance Summary by Campaign reports do not function at all without
manual intervention. Additionally, the new versions of many of the old reports
include enhancements and minor bug fixes. This chapter includes procedures that
describe how to manually fix the old Campaign Performance by Cell reports and
the Offer Performance Summary by Campaign reports so they function with the
new model. This chapter does not describe how to manually apply the
enhancements or minor fixes to the other 7.5.1 reports. To obtain those changes,
you must use the new versions of the reports.

Upgrade scenarios

Source version Upgrade path

Pre-7.5.1 If you are upgrading an IBM Unica Marketing application from a
pre-7.5.1 version, there is no upgrade path for reporting. Instead, see
Chapter 9, “Installing Reports,” on page 47.

7.5.1 If you are upgrading an IBM Unica Marketing application from the
7.5.1 version, perform the steps described in:

v “Preparing to upgrade the reporting components” on page 70

v “Upgrading reports from version 7.5.1” on page 71

Note: Because there is no upgrade path for eMessage from version
7.5.x to 8.x, there is also no upgrade path for the eMessage reports.
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Source version Upgrade path

8.x If you are upgrading an IBM Unica Marketing application from an 8.x
version, perform the steps described in:

v “Preparing to upgrade the reporting components”

v “Upgrading reports from version 7.5.1” on page 71

Preparing to upgrade the reporting components
Before you begin upgrading and configuring reporting, complete the preparatory
tasks in this section.

Step: Verify that a user with the ReportsSystem role exists
If you are upgrading from version 7.x you must configure an IBM Unica Marketing
user with appropriate permissions to work with reporting. If you are upgrading
from 8.x, this user probably exists already.

If you do need to configure this reporting user, see “Step: Set up a user with the
ReportsSystem role, if necessary” on page 47 for instructions.

Confirm that the reporting schemas are upgraded on the
Marketing Platform

Note: If you are upgrading Marketing Operations, skip this step and continue to
“Back up the Cognos model and report archive.” (Marketing Operations does not
have reporting schemas.)

When you ran the IBM Unica Marketing installer to upgrade the Marketing
Platform and to install the report package, you upgraded the reporting schemas.

Verify that the upgraded reporting schemas are on the Marketing Platform.
1. Log in to the IBM Unica Marketing system as the platform_admin user.
2. Select Settings > Configuration.
3. Expand Reports > Schemas > ProductName .

If the schema configuration categories for your application were not upgraded, you
have not yet installed the report package on this IBM Unica system. Locate the
appropriate report package installer, run it now, and select the Product Reporting
Schemas installation option.

Back up the Cognos model and report archive
On the IBM Cognos 8 BI system, complete the following tasks:
v Make a back up copy of the model subdirectory. That is, locate the application

model and copy the entire subdirectory.
v Use the export feature in Cognos Connection to create a backup of the

application's reports archive.

Upgrade IBM Cognos 8 BI, if necessary
If you are upgrading reporting from version 7.5x, you must upgrade Cognos 8 BI
8.3 to IBM Cognos 8 BI 8.4.
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If you are upgrading reporting from version 8.x, your version of IBM Cognos is
already the correct one.

For help with this task, see the IBM Cognos 8.4 documentation.

Upgrading reports from version 7.5.1
Follow the steps in this section if you are upgrading an IBM Unica Marketing
application from version 7.5.1.

Step: Upgrade the reporting schemas and the views or
reporting tables

Note: If you are upgrading Marketing Operations, skip this step and continue to
“Step: Obtain the JDBC driver for the Marketing Platform system tables” on page
58. (Marketing Operations does not have reporting schemas.)

After you have upgraded Affinium Manager to Marketing Platform (including
running the report pack installer with the Marketing Platform installation),
complete the following steps:
1. Navigate to the Unica\[product]ReportsPack\schema directory and locate the

templates_sql_load.sql script.
2. Run the script in the Marketing Platform system tables database.
3. Ensure that the Marketing Platform is running.
4. Log in to IBM Unica Marketing as a user with administrator privileges.
5. Under Settings > Users, give yourself the ReportsSystem role. Then log out

and log back in.
6. Campaign only. The database schema for adding new campaign attributes

changed in Campaign 8.0.0. Therefore, if the reporting schema customizations
included additional campaign attributes, do the following:
a. Use your database management tools to determine the value from each

attribute's AttributeID column in the UA_CampAttribute table.
b. In IBM Unica Marketing, select Settings > Configuration and expand

Reports > Schemas > Campaign > Campaign Custom Attributes >
Columns > Campaign.

c. Delete the existing custom campaign attributes that were added for this
installation, but do not delete the standard custom campaign attributes. (The
standard custom campaign attributes were upgraded by the installer.)

d. Re-create the attributes you deleted. Enter the ID of the attribute in the
Attribute ID field.

7. Follow the steps in the procedure named “Step: Generate the view or table
creation scripts” on page 50 to generate the new versions of the scripts.

8. Use the procedures in the section “Step: Create the reporting views or tables”
on page 51 to create the new versions of the reporting views or tables.

Step: Obtain the JDBC driver for the Marketing Platform
system tables

Obtain the JDBC drivers and any required associated files that you used to
configure the JDBC data source for the Marketing Platform's system tables when
you set up the IBM Unica Marketing system. In a task later in this chapter, you
configure Cognos to use IBM Unica Marketing authentication. Cognos needs the

Chapter 10. Upgrading reports 71



JDBC driver so it can obtain user information from the Marketing Platform system
tables when it uses IBM Unica Marketing authentication.

Copy the JDBC driver to the machine where the Cognos Content Manager is
installed, to the webapps\p2pd\WEB-INF\AAA\lib directory under your Cognos
installation.

Step: Run the installers and upgrade the IBM Unica
integration components

If your is a distributed Cognos installation, determine which machine is running
the Cognos Content manager.
1. Stop the IBM Cognos service.
2. On the IBM Cognos 8 BI system that runs the Cognos Content Manager,

download or copy the following IBM Unica installers to a single directory:
v IBM Unica
v Marketing Platform
v IBM Unica application report package(s)

3. Run the IBM Unica installer. (It will launch the sub-installers for the
Marketing Platform and the report package in order.)

4. In the first Products window, ensure that both the Marketing Platform and the
report package options are selected.

5. In the Platform Database Connection window, provide the necessary
information about how to connect to the Marketing Platform system tables.

6. When the installer asks whether you want to upgrade Affinium Manager,
specify No.

7. When the Platform Installation Components window appears, select the
Reports for IBM Cognos 8.4 option and clear the other options

8. When the Marketing Platform installer prompts for the path to the JDBC
driver, enter the fully qualified path for the JDBC driver you copied to the
Cognos system during the task “Step: Obtain the JDBC driver for the
Marketing Platform system tables” on page 58.

9. When the Marketing Platform installer prompts for the location of the IBM
Cognos installation, enter or browse to the top level of the IBM Cognos
installation directory. Note that the default value provided in this field is a
static value that is not based on the actual file structure of your IBM Cognos
system.

10. When the report package installer takes over and displays its installation
options, select the IBM Cognos package for IBM Unica [product] option and
clear the option for the reporting schemas. This installation option copies the
reports archive to the Cognos machine. You import this archive manually later.

11. When the installers are finished, copy the JDBC driver for the Marketing
Platform database to the IBM Cognos webapps\p2pd\WEB-INF\AAA\lib
directory. Be sure to copy the driver. Do not cut and paste the driver.

12. Restart the IBM Cognos server.

Step: Upgrade the 7.5.1 model and install the new reports
The version 8.x report packages include new and changed reports as well as
Dashboard reports for most of the IBM Unica applications. Although the model
can be upgraded, your 7.5.1 reports cannot. Instead you must install the new 8.x
reports and then either re-create the reporting customizations you made to the
7.5.1 versions or copy the old reports back into the folder.
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1. Verify that you backed up the model and the old reports.
2. Navigate to the Unica\ProductNameReportsPack\Cognos8 directory.
3. Copy the reports archive .zip file (for example Unica Reports for

Campaign.zip) to the directory where your Cognos deployment archives are
saved.
The default location is the deployment directory under your IBM Cognos
installation and it is specified in the Cognos Configuration tool installed with
the Cognos Content Manager. For example: cognos\deployment.
In a distributed IBM Cognos environment, this is a location on the system
running the Content Manager.

4. Only if you did not install your IBM Unica product to the default directory
(C:\Unica on Windows) update some upgrade scipts as described in this step.
You must update the following scripts.
v 80to81upgrade.xml

v 81to85upgrade.xml

This scripts are located in the Unica\ReportsPackProductName\cognos8\
ProductNameModel directory.
Edit the following file paths to reflect your product install location.
v lnstall_directory\ReportsPackCampaign\cognos8\CampaignModel\

translations\fr\translations.txt

v lnstall_directory\ReportsPackCampaign\cognos8\CampaignModel\
translations\de\translations.txt

v lnstall_directory\ReportsPackCampaign\cognos8\CampaignModel\
translations\es\translations.txt

5. Open Cognos Connection.
6. Select Administer Cognos Content > Configuration > Content

Administration.

7. Click the New Import button on the toolbar and import the reports
folder.

8. Open Cognos Framework Manager.
9. Select Project > Run Script.

10. Run the upgrade751to 80.xml script, located in the Unica\
ProductNameReportsPack\cognos8\ProductNameModel directory.

11. Run the 80to81upgrade.xml script.
12. Publish the package to the Cognos content store.
13. Run a report to ensure that it works properly.
14. If the 7.5.1 reports were customized, recreate those customizations. Alternately,

if you can ensure that an old report will work properly with the upgraded
model, copy the old report back. For information about fixing the old
Campaign Performance by Cell reports and the old Offer Performance
Summary by Campaign reports so they work with the new data model,
continue with the remaining procedures in this section.

15. If you have reports installed for multiple partitions, configure a reports
packages for the additional partitions using the instructions in the chapter that
describes how to configure multiple partitions.

16. Optional. See “Configure IBM Cognos to use IBM Unica Marketing
authentication” on page 64 for information about the new authentication
mode, "authenticate per user."
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Step: Updating the old Campaign Performance by Cell reports
After you upgrade the Campaign model from 7.5.1 to 8.x, the old Campaign
Performance by Cell reports do not function properly. If you want to use your old
Campaign Performance by Cell reports rather than the new ones, you must
manually update them yourself.

How to fix the cross-object Performance by Cell reports
Use this procedure to fix the old versions of the following cross-object reports so
they function with the new data model.
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell (with Revenue)
v Campaign Performance Summary by Cell by Initiative

Complete the following steps.
1. Open the report in IBM Cognos Report Studio.
2. Click the lock icon on the toolbar to unlock the report.
3. Browse to the Query Explorer and open the Report Query for a list of all the

query items in the report.
4. For all three reports, remap the following query items as follows:

Query item Mapping

Number of Offers Given [Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Number of Offers Given]

Response Transactions [Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Response Transactions]

Unique Recipients [Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Unique Recipients]

Unique Responders [Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Unique Responders]

Unique Recipients Control
Group

[Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Unique Recipients Control Group]

Unique Responders
Control Group

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Unique Responders Control Group]

5. For the report with revenue, remap for the Gross Revenue item as follows:
[Campaign Performance Summary].[Campaign Cell RH with Controls
Summary].[Gross Revenue]

6. Update the formula for the Responder Rate Control Group to be the
following:
IF(([Unique Responders Control Group]/([Unique Recipients Control Group]

* 1.00)) is missing)
THEN (0)
ELSE(([Unique Responders Control Group]/([Unique Recipients Control Group]

* 1.00)))

7. From the Detail Filter list, select the first detail filter and edit it so it looks
like this:
[Campaign Performance Summary] . [Campaign] . [Campaign ID] in
(?CampaignIds?)

8. From the Detail Filter list, delete the second detail filter – the one that looks
like this:
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[Campaign Performance Summary].[Responder Rate Control Group at Cell
Level].[Campaign ID] in (?CampaignIds?)

9. Lock the report.
10. Do the following in Report Studio for each report.

a. Go to File > Report Package.
b. Select "Unica Campaign Package" and click OK.
c. Fill in prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response

window.
11. Save and run the report.

How to fix the object-specific Performance by Cell reports
Use this procedure to fix the old versions of the following object specific reports to
function with the new data model.
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell (with Revenue)

Complete the following steps.
1. Open the report in IBM Cognos Report Studio.
2. Click the lock icon on the toolbar to unlock the report.
3. Browse to the Query Explorer and open the Report Query for a list of all the

query items in the report.
4. For both reports, remap the following query items as follows:

Query item Mapping

Number of Offers Given [Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Number of Offers Given]

Response Transactions [Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Response Transactions

Unique Recipients [Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Unique Recipients]

Unique Responders [Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Unique Responders]

Unique Recipients Control
Group

[Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Unique Recipients Control Group]

Unique Responders
Control Group

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Unique Responders Control Group]

5. For the report with revenue, remap the Gross Revenue query item as follows:
[Campaign Performance Summary].[Campaign Cell RH with Controls
Summary].[Gross Revenue]

6. Update the formula for the Responder Rate Control Group to be the
following:
IF(([Unique Responders Control Group]/([Unique Recipients Control Group]
* 1.00)) is missing)
THEN (0)
ELSE(([Unique Responders Control Group]/([Unique Recipients Control Group]
* 1.00)))

7. From the Detail Filter list, select the first detail filter and edit it so it looks
like this:
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[Campaign Performance Summary].[Campaign].[Campaign ID] in
(?CampaignIds?)

8. Delete the second detail filter – the one that looks like this:
[Campaign Performance Summary].[Responder Rate Control Group at Cell
Level].[Campaign ID] in (?CampaignIds?)

9. Lock the report.
10. Do the following in Report Studio for each report.

a. Go to File > Report Package.
b. Select "Unica Campaign Package" and click OK.
c. Fill in prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response

window.
11. Save and run the report.

Step: Updating the old Offer Performance Summary by
Campaign reports

After upgrading the Campaign model from 7.5.1 to 8.x, the old Offer Performance
Summary by Campaign reports do not function properly. If you want to use your
old Offer Performance Summary by Campaign reports rather than the new ones,
you must update them manually.

How to fix the Offer Performance Summary by Campaign
cross-object report
Use this procedure to fix the old version of the cross-object Offer Performance
Summary by Campaign report so it functions with the new data model.
1. Open the report in IBM Cognos Report Studio.
2. Browse to the Query Explorer and open the Report Query for a list of all the

query items in the report.
3. Configure the aggregation as follows for the following Campaign Level

Counts query items:

Query item
Aggregate
Function

Rollup Aggregate
Function

Number of Offers Given None Automatic

Response Transactions None Automatic

Unique Recipients None Automatic

Unique Responders None Automatic

Not Contacted Responders None Automatic

Responses after Expiration None Automatic

Unique Recipients Control Group None Automatic

Unique Responders Control Group None Automatic

4. Configure the aggregation as follows for the following Campaign Level
Counts query items:

Query item
Aggregate
Function

Rollup Aggregate
Function

Response Rate Automatic Automatic

Responder Rate Automatic Automatic
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Query item
Aggregate
Function

Rollup Aggregate
Function

Responder Rate Control Group Automatic Automatic

Best Offer Lift Over This Automatic Automatic

Lift Over Worst Offer Automatic Automatic

Lift Over Control Group Automatic Automatic

5. Configure the aggregation as follows for the following Offer Level Counts
query items:

Query item
Aggregate
Function

Rollup Aggregate
Function

Number of Offers Given-Offer None Automatic

Unique Responders-Offer None Automatic

Not Contacted Responders-Offer None Automatic

Responses after Expiration-Offer None Automatic

Unique Responders Control Group-Offer None Automatic

6. Change the expression for the Response Transactions-Offer query item to be
the following:
[Offer Performance Summary].[Offer Response History Summary].
[Response Transactions] / count([Campaign Name] for [Offer ID])

7. Configure the aggregation as follows for the following Offer Level Counts
query items:

Query item
Aggregate
Function

Rollup Aggregate
Function

Response Transactions - Offer Total Automatic

Unique Recipients - Offer Total Automatic

Unique Recipients Control Group - Offer Total Automatic

8. Configure the aggregation as follows for the following Offer Level Counts
query items:

Query item
Aggregate
Function

Rollup Aggregate
Function

Response Rate - Offer Automatic Automatic

Responder Rate - Offer Automatic Automatic

Responder Rate Control Group - Offer Automatic Automatic

Lift Over Control Group - Offer Automatic Automatic

9. For the Report Total level counts, change the expression for Total Response
Transactions to be:
total ([Response Transactions-Offer])

10. Also for Total Response Transactions, confirm that Aggregate Function is set
to Automatic and that Rollup Aggregate Function is set to Automatic.

11. Lock the report.
12. Do the following in Report Studio for each report.

a. Go to File > Report Package
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b. Select "Unica Campaign Package" and click OK.
c. Fill in prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response

window.
13. Save and run the report.

How to fix the single object Offer Performance Summary by
Campaign report
Use this procedure to fix the old version of the single object Offer Performance
Summary by Campaign report so it functions with the new data model.
1. Open the report in IBM Cognos Report Studio.
2. Browse to the Query Explorer and open the Report Query for a list of all the

query items in the report.
3. Configure the aggregation as follows for the following Campaign Level

Counts query items:

Query item
Aggregate
Function

Rollup Aggregate
Function

Number of Offers Given None Automatic

Response Transactions None Automatic

Unique Recipients None Automatic

Unique Responders None Automatic

Not Contacted Responders None Automatic

Responses after Expiration None Automatic

Unique Recipients Control Group None Automatic

Unique Responders Control Group None Automatic

4. Configure the aggregation as follows for the following Campaign Level
Counts query items:

Query item
Aggregate
Function

Rollup Aggregate
Function

Response Rate Automatic Automatic

Responder Rate Automatic Automatic

Responder Rate Control Group Automatic Automatic

Best Offer Lift Over This Automatic Automatic

Lift Over Worst Offer Automatic Automatic

Lift Over Control Group Automatic Automatic

5. Configure the aggregation as follows for the following Offer Level Counts
query items:

Query item
Aggregate
Function

Rollup Aggregate
Function

Number of Offers Given-Offer None Automatic

Unique Responders-Offer None Automatic

Not Contacted Responders-Offer None Automatic

Responses after Expiration-Offer None Automatic
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Query item
Aggregate
Function

Rollup Aggregate
Function

Unique Responders Control Group-Offer None Automatic

6. Change the expression for the Response Transactions-Offer query item to be
the following:
[Offer Performance Summary].[Offer Response History Summary].
[Response Transactions] / count([Campaign Name] for [Offer ID])

7. Configure the aggregation as follows for the following Offer Level Counts
query items:

Query item
Aggregate
Function

Rollup Aggregate
Function

Response Transactions - Offer Total Automatic

Unique Recipients - Offer Total Automatic

Unique Recipients Control Group - Offer Total Automatic

8. Configure the aggregation as follows for the following Offer Level Counts
query items:

Query item
Aggregate
Function

Rollup Aggregate
Function

Response Rate - Offer Automatic Automatic

Responder Rate - Offer Automatic Automatic

Responder Rate Control Group - Offer Automatic Automatic

Lift Over Control Group - Offer Automatic Automatic

9. Lock the report.
10. Do the following in Report Studio for each report.

a. Go to File > Report Package
b. Select "Unica Campaign Package" and click OK.
c. Fill in prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response

window.
11. Save and run the report.

Upgrading reports from version 8.x
Follow the steps in this section if you are upgrading an IBM Unica Marketing
application from version 8.x.

Step: Upgrade the 8.x model and install the new reports
1. Navigate to the Unica\ProductNameReportsPack\Cognos8 directory.
2. Copy the reports archive .zip file (for example Unica Reports for

Campaign.zip) to the directory where your Cognos deployment archives are
saved.
The default location is the deployment directory under your IBM Cognos
installation and it is specified in the Cognos Configuration tool installed with
the Cognos Content Manager. For example: cognos\deployment
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In a distributed IBM Cognos environment, this is a location on the system
running the Content Manager.

3. Only if you did not install your IBM Unica product to the default directory
(C:\Unica on Windows), you must update some upgrade scripts as described
in this step.
You must update the following scipts.
v 80to81upgrade.xml

v 81to85upgrade.xml

The scripts are located in the ProductNameReportsPack\cognos8\
ProductNameModel directory.
Edit the following file paths to reflect your product install location.
v lnstall_directory \ReportsPackCampaign\cognos8\CampaignModel\

translations\fr\translations.txt

v lnstall_directory\ReportsPackCampaign\cognos8\CampaignModel\
translations\de\translations.txt

v lnstall_directory\ReportsPackCampaign\cognos8\CampaignModel\
translations\es\translations.txt

4. Open Cognos Connection.
5. Select Administer Cognos Content > Configuration > Content

Administration.

6. Click the New Import button on the toolbar and import the reports
folder.

7. Open Cognos Framework Manager.
8. Select Project > Run Script.
9. Run the following scripts.

v 80to81upgrade.xml

v 81to85upgrade.xml

The scripts are located in the Unica\ProductReportsPack\cognos8\
ProductNameModel directory.

10. Publish the package to the Cognos content store.
11. Do the following in Cognos Report Studio for each cross-object Performance

by Cell and object-specific Performance by Cell report.
a. Go to File > Report Package.
b. Select "Unica Campaign Package" and click OK.
c. Fill in prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response

window.
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Appendix A. About Marketing Platform utilities

This section provides an overview of the Marketing Platform utilities, including
some details that apply to all of the utilities and which are not included in the
individual utility descriptions.

Location of utilities

Marketing Platform utilities are located in the tools/bin directory under your
Marketing Platform installation.

List and descriptions of utilities

The Marketing Platform provides the following utilities.
v “The configTool utility” on page 83 - imports, exports, and deletes configuration

settings, including product registrations
v “The datafilteringScriptTool utility” on page 87 - creates data filters
v “The encryptPasswords utility” on page 88 - encrypts and stores passwords
v “The partitionTool utility” on page 89 - creates database entries for partitions
v “The populateDb utility” on page 91 - populates the Marketing Platform

database
v “The restoreAccess utility” on page 92 - restores a user with the

platformAdminRole role

Prerequisites for running Marketing Platform utilities

The following are prerequisites for running all Marketing Platform utilities.
v Run all utilities from the directory where they are located (by default, the

tools/bin directory under your Marketing Platform installation).
v On UNIX, the best practice is to run the utilities with the same user account that

runs the application server on which Marketing Platform is deployed. If you run
a utility with a different user account, adjust the permissions on the
platform.log file to allow that user account to write to it. If you do not adjust
permissions, the utility is not able to write to the log file and you might see
some error messages, although the tool should still function correctly.

Troubleshooting connection issues

All of the Marketing Platform utilities except encryptPasswords interact with the
Marketing Platform system tables. To connect to the system table database, these
utilities use the following connection information, which is set by the installer
using information provided when the Marketing Platform was installed. This
information is stored in the jdbc.properties file, located in the tools/bin directory
under your Marketing Platform installation.
v JDBC driver name
v JDBC connection URL (which includes the host, port, and database name)
v Data source login
v Data source password (encrypted)
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In addition, these utilities rely on the JAVA_HOME environment variable, set either in
the setenv script located in the tools/bin directory of your Marketing Platform
installation, or on the command line. The Marketing Platform installer should have
set this variable automatically in the setenv script, but it is a good practice to
verify that the JAVA_HOME variable is set if you have a problem running a utility.
The JDK must be the Sun version (not, for example, the JRockit JDK available with
WebLogic).

Special characters

Characters that are designated as reserved characters in the operating system must
be escaped. Consult your operating system documentation for a list of reserved
characters and how to escape them.

Standard options in Marketing Platform utilities

The following options are available in all Marketing Platform utilities.

-l logLevel

Set the level of log information displayed in the console. Options are high, medium,
and low. The default is low.

-L

Set the locale for console messages. The default locale is en_US. The available
option values are determined by the languages into which the Marketing Platform
has been translated. Specify the locale using the ICU locale ID according to ISO
639-1 and ISO 3166.

-h

Display a brief usage message in the console.

-m

Display the manual page for this utility in the console.

-v

Display more execution details in the console.

Running Marketing Platform utilities on additional machines
On the machine where the Marketing Platform is installed, you can run the
Marketing Platform utilities without any additional configuration. However, you
might want to run the utilities from another machine on the network. This
procedure describes the steps required to do this.

To set up Marketing Platform utilities on additional machines
1. Ensure that the machine on which you perform this procedure meets the

following prerequisites.
v The correct JDBC driver must exist on the machine or be accessible from it.
v The machine must have network access to the Marketing Platform system

tables.
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v The Java runtime environment must be installed on the machine or be
accessible from it.

2. Gather the following information about the Marketing Platform system tables.
v The fully qualified path for the JDBC driver file or files on your system.
v The fully qualified path to an installation of the Java runtime environment.

The default value in the installer is the path to the 1.5 version of the JRE that
the installer places under your IBM Unica installation directory. You can
accept this default or specify a different path.

v Database type
v Database host
v Database port
v Database name/system ID
v Database user name
v Database password

3. Run the IBM installer and install the Marketing Platform.
Enter the database connection information that you gathered for the Marketing
Platform system tables. If you are not familiar with the IBM installer, see the
Campaign or Marketing Operations installation guide.
You do not have to deploy the Marketing Platform web application.

Reference: Marketing Platform utilities
This section describes the Marketing Platform utilities, with functional details,
syntax, and examples.

The configTool utility
The properties and values on the Configuration page are stored in the Marketing
Platform system tables. The configTool utility imports and exports configuration
settings to and from the Marketing Platform system tables.

When to use configTool

You might want to use configTool for the following reasons.
v To import partition and data source templates supplied with Campaign, which

you can then modify and/or duplicate using the Configuration page.
v To register (import configuration properties for) IBM Unica Marketing products,

if the product installer is unable to add the properties to the database
automatically.

v To export an XML version of configuration settings for backup or to import into
a different installation of IBM Unica Marketing.

v To delete categories that do not have the Delete Category link. You do this by
using configTool to export your configuration, then manually deleting the XML
that creates the category, and using configTool to import the edited XML.

Important: This utility modifies the usm_configuration and
usm_configuration_values tables in the Marketing Platform system table database,
which contain the configuration properties and their values. For best results, either
create backup copies of these tables, or export your existing configurations using
configTool and back up the resulting file so you have a way to restore your
configuration if you make an error when using configTool to import.
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Valid product names

The configTool utility uses product names as parameters with the commands that
register and unregister products, as described later in this section. With the 8.0.0
release of IBM Unica Marketing, many product names changed. However, the
names recognized by configTool did not change. The valid product names for use
with configTool are listed below, along with the current names of the products.

Product name Name used in configTool

Marketing Platform Manager

Campaign Campaign

Distributed Marketing Collaborate

eMessage emessage

Interact interact

Optimize Optimize

Marketing Operations Plan

CustomerInsight Insight

NetInsight NetInsight

PredictiveInsight Model

Leads Leads

Syntax

configTool -d -p "elementPath" [-o]

configTool -i -p "parent ElementPath" -f importFile [-o]

configTool -x -p "elementPath" -f exportFile

configTool -r productName -f registrationFile [-o]

configTool -u productName

Commands

-d -p "elementPath"

Delete configuration properties and their settings, specifying a path in the
configuration property hierarchy.

The element path must use the internal names of categories and properties, which
you can obtain by going to the Configuration page, selecting the wanted category
or property, and looking at the path displayed in parentheses in the right pane.
Delimit a path in the configuration property hierarchy using the | character, and
surround the path with double quotes.

Note the following.
v Only categories and properties within an application may be deleted using this

command, not whole applications. Use the -u command to unregister a whole
application.
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v To delete categories that do not have the Delete Category link on the
Configuration page, use the -o option.

-i -p "parentElementPath" -f importFile

Import configuration properties and their settings from a specified XML file.

To import, you specify a path to the parent element under which you want to
import your categories. The configTool utility imports properties under the
category you specify in the path.

You can add categories at any level below the top level, but you cannot add a
category at same level as the top category.

The parent element path must use the internal names of categories and properties,
which you can obtain by going to the Configuration page, selecting the desired
category or property, and looking at the path displayed in parentheses in the right
pane. Delimit a path in the configuration property hierarchy using the | character,
and surround the path with double quotes.

You can specify an import file location relative to the tools/bin directory or you
can specify a full directory path. If you specify a relative path or no path,
configTool first looks for the file relative to the tools/bin directory.

By default, this command does not overwrite an existing category, but you can use
the -o option to force an overwrite.

-x -p "elementPath" -f exportFile

Export configuration properties and their settings to an XML file with a specified
name.

You can export all configuration properties or limit the export to a specific category
by specifying a path in the configuration property hierarchy.

The element path must use the internal names of categories and properties, which
you can obtain by going to the Configuration page, selecting the wanted category
or property, and looking at the path displayed in parenthesis in the right pane.
Delimit a path in the configuration property hierarchy using the | character, and
surround the path with double quotes.

You can specify an export file location relative to the current directory or you can
specify a full directory path. If the file specification does not contain a separator (/
on Unix, / or \ on Windows), configTool writes the file to the tools/bin directory
under your Marketing Platform installation. If you do not provide the xml
extension, configTool adds it.

-r productName -f registrationFile

Register the application. The registration file location may be relative to the
tools/bin directory or may be a full path. By default, this command does not
overwrite an existing configuration, but you can use the -o option to force an
overwrite. The productName parameter must be one of those listed above.

Note the following.
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v When you use the -r option, the registration file must have <application> as
the first tag in the XML.
Other files may be provided with your product that you can use to insert
configuration properties into the Marketing Platform database. For these files,
use the -i option. Only the file that has the <application> tag as the first tag
can be used with the -r option.

v The registration file for the Marketing Platform is named Manager_config.xml,
and the first tag is <Suite>. To register this file on a new installation, use the
populateDb utility, or rerun the Marketing Platform installer as described in the
IBM Unica Marketing Platform Installation Guide.

v After the initial installation, to reregister products other than the Marketing
Platform, use configTool with the -r option and -o to overwrite the existing
properties.

-u productName

Unregister an application specified by productName . You do not have to include a
path to the product category; the product name is sufficient. The productName
parameter must be one of those listed above. This removes all properties and
configuration settings for the product.

Options

-o

When used with -i or -r, overwrites an existing category or product registration
(node).

When used with -d allows you to delete a category (node) that does not have the
Delete Category link on the Configuration page.

Examples
v Import configuration settings from a file named Product_config.xml located in

the conf directory under the Marketing Platform installation.
configTool -i -p "Affinium" -f Product_config.xml

v Import one of the supplied Campaign data source templates into the default
Campaign partition, partition1. The example assumes that you placed the Oracle
data source template, OracleTemplate.xml, in the tools/bin directory under the
Marketing Platform installation.
configTool -i -p "Affinium|Campaign|partitions|partition1|dataSources" -f
OracleTemplate.xml

v Export all configuration settings to a file named myConfig.xml located in the
D:\backups directory.
configTool -x -f D:\backups\myConfig.xml

v Export an existing Campaign partition (complete with data source entries), save
it to a file named partitionTemplate.xml, and store it in the default tools/bin
directory under the Marketing Platform installation.
configTool -x -p "Affinium|Campaign|partitions|partition1" -f
partitionTemplate.xml

v Manually register an application named productName, using a file named
app_config.xml located in the default tools/bin directory under the Marketing
Platform installation, and force it to overwrite an existing registration of this
application.
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configTool -r product Name -f app_config.xml -o

v Unregister an application named productName.
configTool -u productName

The datafilteringScriptTool utility
The datafilteringScriptTool utility reads an XML file to populate the data
filtering tables in the Marketing Platform system table database.

Depending on how you write the XML, you can use this utility in two ways.
v Using one set of XML elements, you can auto-generate data filters based on

unique combinations of field values (one data filter for each unique
combination).

v Using a slightly different set of XML elements, you can specify each data filter
that the utility creates.

See IBM Unica Marketing Platform the Administrator's Guide for information about
creating the XML.

When to use datafilteringScriptTool

You must use datafilteringScriptTool when you create new data filters.

Prerequisites

The Marketing Platform must be deployed and running.

Using datafilteringScriptTool with SSL

When the Marketing Platform is deployed using one-way SSL you must modify
the datafilteringScriptTool script to add the SSL options that perform handshaking.
To modify the script, you must have the following information.
v Truststore file name and path
v Truststore password

In a text editor, open the datafilteringScriptTool script (.bat or .sh) and find the
lines that look like this (examples are Windows version).

:callexec

"%JAVA_HOME%\bin\java" -DUNICA_PLATFORM_HOME="%UNICA_PLATFORM_HOME%"

com.unica.management.client.datafiltering.tool.DataFilteringScriptTool %*

Edit these lines to look like this (new text is in bold). Substitute your truststore
path and file name and truststore password for myTrustStore.jks and myPassword.

:callexec

SET SSL_OPTIONS=-Djavax.net.ssl.keyStoreType="JKS"

-Djavax.net.ssl.trustStore="C:\security\myTrustStore.jks"

-Djavax.net.ssl.trustStorePassword=myPassword
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"%JAVA_HOME%\bin\java" -DUNICA_PLATFORM_HOME="%UNICA_PLATFORM_HOME%"
%SSL_OPTIONS%

com.unica.management.client.datafiltering.tool.DataFilteringScriptTool %*

Syntax

datafilteringScriptTool -r pathfile

Commands

-r path_file

Import data filter specifications from a specified XML file. If the file is not located
in the tools/bin directory under your installation, provide a path and enclose the
path_file parameter in double quotation marks.

Example
v Use a file named collaborateDataFilters.xml, located in the C:\unica\xml

directory, to populate the data filter system tables.
datafilteringScriptTool -r "C:\unica\xml\collaborateDataFilters.xml"

The encryptPasswords utility
The encryptPasswords utility is used to encrypt and store either of two passwords
that the Marketing Platform uses, as follows.
v The password that the Marketing Platform uses to access its system tables. The

utility replaces an existing encrypted password (stored in the jdbc,properties
file, located in the tools\bin directory under your Marketing Platform
installation) with a new one.

v The keystore password used by the Marketing Platform when it is configured to
use SSL with a certificate other than the default one supplied with the Marketing
Platform or the web application server. The certificate can be either a self-signed
certificate or a certificate from a certificate authority.

When to use encryptPasswords

Use encryptPasswords as for the following reasons.
v When you change the password of the account used to access your Marketing

Platform system table database.
v When you have created a self-signed certificate or have obtained one from a

certificate authority.

Prerequisites
v Before running encryptPasswords to encrypt and store a new database password,

make a backup copy of the jdbc.properties file, located in the tools/bin
directory under your Marketing Platform installation.

v Before running encryptPasswords to encrypt and store the keystore password,
you must have created or obtained a digital certificate and know the keystore
password.

See Appendix A, “About Marketing Platform utilities,” on page 81 for additional
prerequisites.
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Syntax

encryptPasswords -d databasePassword

encryptPasswords -k keystorePassword

Commands

-d databasePassword

Encrypt the database password.

-k keystorePassword

Encrypt the keystore password and store it in a file named pfile.

Examples
v When the Marketing Platformwas installed, the login for the system table

database account was set to myLogin. Now, some time after installation, you have
changed the password for this account to newPassword. Run encryptPasswords as
follows to encrypt and store the database password.
encryptPasswords -d newPassword

v You are configuring an IBM Unica Marketing application to use SSL and have
created or obtained a digital certificate. Run encryptPasswords as follows to
encrypt and store the keystore password.
encryptPasswords -k myPassword

The partitionTool utility
Partitions are associated with Campaign policies and roles. These policies and roles
and their partition associations are stored in the Marketing Platform system tables.
The partitionTool utility seeds the Marketing Platform system tables with basic
policy and role information for partitions.

When to use partitionTool

For each partition you create, you must use partitionTool to seed the Marketing
Platform system tables with basic policy and role information.

See the installation guide appropriate for your version of Campaign for detailed
instructions on setting up multiple partitions in Campaign.

Special characters and spaces

Any partition description or user, group, or partition name that contains spaces
must be enclosed in double quotation marks.

See Appendix A, “About Marketing Platform utilities,” on page 81 for additional
restrictions.

Syntax

partitionTool -c -s sourcePartition -n newPartitionName [-u
admin_user_name] [-d partitionDescription] [-g groupName]
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Commands

The following commands are available in the partitionTool utility.

-c

Replicates (clones) the policies and roles for an existing partition specified using
the -s option, and uses the name specified using the -n option. Both of these
options are required with c. This command does the following.
v Creates a new IBM Unica Marketing user with the Admin role in both the

Administrative Roles policy and the global policy in Campaign. The partition
name you specify is automatically set as this user’s password.

v Creates a new Marketing Platform group and makes the new Admin user a
member of that group.

v Creates a new partition object.
v Replicates all the policies associated with the source partition and associates

them with the new partition.
v For each replicated policy, replicates all roles associated with the policy.
v For each replicated role, maps all functions in the same way that they were

mapped in the source role.
v Assigns the new Marketing Platform group to the last system-defined Admin

role created during role replication. If you are cloning the default partition,
partition1, this role is the default Administrative Role (Admin).

Options

-d partitionDescription

Optional, used with -c only. Specifies a description that appears in the output from
the -list command. Must be 256 characters or less. Enclose in double quotation
marks if the description contains spaces.

-g groupName

Optional, used with -c only. Specifies the name of the Marketing Platform Admin
group that the utility creates. The name must be unique within this instance of the
Marketing Platform

If not defined, the name defaults to partition_nameAdminGroup.

-n partitionName

Optional with -list, required with -c. Must be 32 characters or less.

When used with -list, specifies the partition whose information is listed.

When used with -c, specifies the name of the new partition, and the partition
name you specify is used as the password for the Admin user. The partition name
must match the name you gave the partition in when you configured it (using the
partition template on the Configuration page).

-s sourcePartition

Required, used with -c only. The name of the source partition to be replicated.
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-u adminUserName

Optional, used with -c only. Specifies the user name of the Admin user for the
replicated partition. The name must be unique within this instance of the
Marketing Platform.

If not defined, the name defaults to partitionNameAdminUser.

The partition name is automatically set as this user’s password.

Examples
v Create a partition with the following characteristics.

– Cloned from partition1
– Partition name is myPartition

– Uses the default user name (myPartitionAdminUser) and password
(myPartition)

– Uses the default group name (myPartitionAdminGroup)
– Description is “ClonedFromPartition1”

partitionTool -c -s partition1 -n myPartition -d "ClonedFromPartition1"

v Create a partition with the following characteristics.
– Cloned from partition1
– Partition name is partition2

– Specifies user name of customerA with the automatically assigned password of
partition2

– Specifies group name of customerAGroup
– Description is “PartitionForCustomerAGroup”

partitionTool -c -s partition1 -n partition2 -u customerA -g
customerAGroup -d "PartitionForCustomerAGroup"

The populateDb utility
The populateDb utility inserts default (seed) data in the Marketing Platform system
tables.

The IBM installer can populate the Marketing Platform system tables with default
data for the Marketing Platform and for Campaign. However, if your company
policy does not permit the installer to change the database, or if the installer is
unable to connect with the Marketing Platform system tables, you must insert
default data in the Marketing Platform system tables using this utility.

For Campaign, this data includes security roles and permissions for the default
partition. For the Marketing Platform, this data includes configuration properties,
default users and groups, and security roles and permissions for the default
partition.

Syntax

populateDb -n productName

Commands

-n productName
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Insert default data into the Marketing Platform system tables. Valid product names
are Manager (for the Marketing Platform) and Campaign (for Campaign).

Examples
v Insert Marketing Platform default data manually.

populateDb -n Manager

v Insert Campaign default data manually.
populateDb -n Campaign

The restoreAccess utility
The restoreAccess utility allows you to restore access to the Marketing Platform if
all users with PlatformAdminRole privileges have been inadvertently locked out or
if all ability to log in to the Marketing Platform has been lost.

When to use restoreAccess

You might want to use restoreAccess under the two circumstances described in
this section.

PlatformAdminRole users disabled

It is possible that all users with PlatformAdminRole privileges in the Marketing
Platformmight become disabled in the system. Here is an example of how the
platform_admin user account might become disabled. Suppose you have only one
user with PlatformAdminRole privileges (the platform_admin user). Assume the
Maximum failed login attempts allowed property property in the General |
Password settings category on the Configuration page is set to 3. Then suppose
someone who is attempting to log in as platform_admin enters an incorrect
password three times in a row. These failed login attempts cause the
platform_admin account to become disabled in the system.

In that case, you can use restoreAccess to add a user with PlatformAdminRole
privileges to the Marketing Platform system tables without accessing the web
interface.

When you run restoreAccess in this way, the utility creates a user with the login
name and password you specify, and with PlatformAdminRole privileges.

If the user login name you specify exists in the Marketing Platform as an internal
user, that user’s password is changed.

Only a user with the login name of PlatformAdmin and with PlatformAdminRole
privileges can universally administer all dashboards. So if the platform_admin user
is disabled and you create a user with restoreAccess, you should create a user
with a login of platform_admin.

Improper configuration of Active Directory integration

If you implement Windows Active Directory integration with improper
configuration and can no longer log in, use restoreAccess to restore the ability to
log in.

When you run restoreAccess in this way, the utility changes the value of the
Platform | Security | Login method property from Windows integrated login to
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Marketing Platform. This change allows you to log in with any user account that
existed before you were locked out. You can optionally specify a new login name
and password as well. You must restart the web application server on which the
Marketing Platform is deployed if you use the restoreAccess utility in this way.

Password considerations

Note the following about passwords when you use restoreAccess.
v The restoreAccess utility does not support blank passwords, and does not

enforce password rules.
v If you specify a user name that is in use, the utility resets the password for that

user.

Syntax

restoreAccess -u loginName -p password

restoreAccess -r

Commands

-r

When used without the -u loginName option, reset the value of the Unica |
Security | Login method property to Marketing Platform. Requires restart of the
web application server to take effect.

When used with the -u loginName option, create a PlatformAdminRole user.

Options

-u loginNname

Create a user with PlatformAdminRole privileges with the specified login name.
Must be used with the -p option.

-p password

Specify the password for the user being created. Required with -u.

Examples
v Create a user with PlatformAdminRole privileges. The login name is tempUser

and the password is tempPassword.
restoreAccess -u tempUser -p tempPassword

v Change the value of the login method to Unica Marketing Platform and create a
user with PlatformAdminRole privileges. The login name is tempUser and the
password is tempPassword.
restoreAccess -r -u tempUser -p tempPassword

About Marketing Platform SQL scripts
This section describes the SQL scripts provided with the Marketing Platform to
perform various tasks relating to the Marketing Platform system tables. They are
designed to be run against the Marketing Platform system tables.
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The Marketing Platform SQL scripts are located in the db directory under your
Marketing Platform installation.

You must use the database client to run the SQL against the Marketing Platform
system tables.

Reference: Marketing Platform SQL scripts
This section describes the Marketing Platform SQL scripts.

Removing all data (ManagerSchema_DeleteAll.sql)
The Manager_Schema_DeleteAll.sql script removes all data from the Marketing
Platform system tables without removing the tables themselves. This script
removes all users, groups, security credentials, data filters, and configuration
settings from the Marketing Platform.

When to use ManagerSchema_DeleteAll.sql

You might want to use ManagerSchema_DeleteAll.sql if corrupted data prevents
you from using an instance of the Marketing Platform.

Additional requirements

To make the Marketing Platform operational after running
ManagerSchema_DeleteAll.sql , you must perform the following steps.
v Run the populateDB utility as described in “The populateDb utility” on page 91.

The populateDB utility restores the default configuration properties, users, roles,
and groups, but does not restore any users, roles, and groups you have created
or imported after initial installation.

v Use the configTool utility with the config_navigation.xml file to import menu
items, as described in “The configTool utility” on page 83.

v If you have performed any post-installation configuration, such as creating data
filters or integrating with an LDAP server or web access control platform, you
must perform these configurations again.

v If you want to restore previously existing data filters, run the
datafilteringScriptTool utility using the XML originally created to specify the
data filters.

Removing data filters only
(ManagerSchema_PurgeDataFiltering.sql)

The ManagerSchema_PurgeDataFiltering.sql script removes all data filtering data
from the Marketing Platform system tables without removing the data filter tables
themselves. This script removes all data filters, data filter configurations,
audiences, and data filter assignments from the Marketing Platform.

When to use ManagerSchema_PurgeDataFiltering.sql

You might want to use ManagerSchema_PurgeDataFiltering.sql if you need to
remove all data filters without removing other data in the Marketing Platform
system tables.

Important: The ManagerSchema_PurgeDataFiltering.sql script does not reset the
values of the two data filter properties, Default table name and Default audience
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name. If these values are no longer valid for the data filters you want to use, you
must set the values manually on the Configuration page.

Removing system tables (ManagerSchema_DropAll.sql)
The ManagerSchema_DropAll.sql script removes all Marketing Platform system
tables from a database. This script removes all tables, users, groups, security
credentials, and configuration settings from the Marketing Platform.

Note: If you run this script against a database containing an earlier version of the
Marketing Platform system tables, you might receive error messages in your
database client stating that constraints do not exist. Youcan safely ignore these
messages.

When to use ManagerSchema_DropAll.sql

You might want to use ManagerSchema_DropAll.sql if you have uninstalled an
instance of the Marketing Platform where the system tables are in a database that
contains other tables you want to continue using.

Additional requirements

To make the Marketing Platform operational after running this script, you must
perform the following steps.
v Run the appropriate SQL script to re-create the system tables, as described in

“Creating system tables.”
v Run the populateDB utility as described in “The populateDb utility” on page 91.

Running the populateDB utility restores the default configuration properties,
users, roles, and groups, but does not restore any users, roles, and groups you
have created or imported after initial installation.

v Use the configTool utility with the config_navigation.xml file to import menu
items, as described in “The configTool utility” on page 83.

v If you have performed any post-installation configuration, such as creating data
filters or integrating with an LDAP server or web access control platform, you
must perform these configurations again.

Creating system tables

Use the scripts described in the following table to create Marketing Platform
system tables manually, when your company policy does not allow you to use the
installer to create them automatically. The scripts are shown in the order in which
you must run them.

Datasource Type Script Names

IBM DB2
v ManagerSchema_DB2.sql

If you plan to support multi-byte characters (for example,
Chinese, Japanese, or Korean), use the
ManagerSchema_DB2_unicode.sql script.

v ManagerSchema__DB2_CeateFKConstraints.sql

v active_portlets.sql

Microsoft SQL Server
v ManagerSchema_SqlServer.sql

v ManagerSchema__SqlServer_CeateFKConstraints.sql

v active_portlets.sql
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Datasource Type Script Names

Oracle
v ManagerSchema_Oracle.sql

v ManagerSchema__Oracle_CeateFKConstraints.sql

v active_portlets.sql

If you plan to use the Scheduler feature that enables you to configure a flowchart
to run at predefined intervals, you must also create the tables that support this
feature. To create the Scheduler tables, run the appropriate script, as described in
the following table.

Data Source Type Script Name

IBM DB2 quartz_db2.sql

Microsoft SQL Server quartz_sqlServer.sql

Oracle quartz_oracle.sql

When to use the create system tables scripts

You must use these scripts when you install or upgrade the Marketing Platform if
you have not allowed the installer to create the system tables automatically, or if
you have used ManagerSchema_DropAll.sql to delete all Marketing Platform system
tables from your database.
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Appendix B. Uninstalling IBM Unica products

You might need to uninstall an IBM Unica product if you are doing the following.
v Retiring a system.
v Removing an IBM Unica product from your system.
v Freeing up space on a system.

When you install IBM Unica Marketing products, an uninstaller is included in the
Uninstall_Product directory, where Product is the name of your IBM Unica
product. On Windows, an entry is also added to the Add or Remove Programs list
in the Control Panel.

Running the IBM Unica uninstaller ensures that all configuration files, installer
registry information, and user data are removed from the system. If you manually
remove the files in your installation directory instead of running the uninstaller,
the result might be an incomplete installation if you later reinstall an IBM Unica
product in the same location.

To uninstall IBM Unica products
Follow these instructions to properly remove IBM Unica products from your
system.

Note: On UNIX, the same user account that installed IBM Unica Marketing must
run the uninstaller.
1. Undeploy the IBM Unica Marketing product web application from WebSphere

or WebLogic.
2. Shut down WebSphere or WebLogic.
3. Stop any running processes that are related to the product you are uninstalling.

For example, stopping the Campaign or Optimize Listener services before
uninstalling those products.

4. Run the IBM Unica Marketing uninstaller and follow the directions in the
wizard.
The uninstaller is located in the Uninstall_Product directory, where Product is
the name of your IBM Unica Marketing product.
When you uninstall a product that was installed using unattended mode, the
uninstall is performed in unattended mode (without presenting any dialogs for
user interaction).
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information about the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
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been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.
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